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Foreword

When I first got Unreal, I had read about it advance and knew what the package contained. Therefore I couldn't wait to get my hands on the editor. My previous level editing experience had been with Ben Morris' WorldCraft for Quake and Quake 2, and if it was anything as good as that, I would be satisfied. However, it turned out that I didn't understand squat of UnrealEd! Besides, it was too unstable to get a decent trial-and-error thing going, and thus, I put my UnrealEd level editing to rest until it had become more stable.

Then the 209 beta patch was released, and it seemed to have straightened up a few things, but not many. It was still too buggy for me to efficiently figure it out on my one, so one day I started to do some research on the Net, and I found that while I had been banging my head on the wall ,there had been written quite a few good tutorials on how to use UnrealEd and its features. After my downloading frenzy had settled down a bit, I gradually started to learn, and for each new step, I got a new understanding of how omnipotent UnrealEd actually was.

There was one downside to using all these tutorials though: I ended up with thousands of them in the taskbar while editing. My preference is to have the tutorials printed, and therefore I decided to collect all the tutorials I found to be the best, in one document for printing. This is my way of giving something back to the Unreal editing community, who has been a tremendous help!

I hope you'll find it useful!

Fleshdance

The Jargon

By: Millenium 2002

Dated: 7/11/98 

I will start this tutorial by explaining a little of how the editor actually works. This editor is unlike most editors around. It also differs from many 3D Programs that are available for purchase. You will find that most programs that are available will start the screen off with a huge "empty" area. Thus if you would want to build something, you will have to "add" to the world. What makes the Unreal Editor different is that the world that you start off with is actually a huge great SOLID block. It does not have any empty or blank space in it. Thus if you would like to create a room in the world, then you actually have to "subtract" it from the world. If this may seem a little "backwards" with the way that most editors work, then I agree with you, but at the same time, I do also think that this does make a lot of sense. In most of the other editors, you would have to create a solid "wall" to show the last part of a level (or world) before the editor would allow you to actually see it. Thus you would have to create a large number of addition brushes simply to have a finite size of the level. With the Epic Editor (for Unreal) you do not have to create a "final" barrier to your world, but simply each time you subtract a room (or space) from the editor, then it automatically adds to the area that you can travel in the game. Thus, it does make our lives somewhat easier, and also does make a smaller load on the processor of the PC playing it, as it does not have to count and use as many brushes, as if you would have extra brushes to mark the final point of a level. Ok, now that we know a little of how the editor works, let's get into some of the more technical words that you will probably hear mentioned a lot in my tutorials and other people when they talk about the editor. The amount of detail I will go into will vary on how important I think something is, and if it is really important that you know what each word means. 

Brushes 

· Solid Brushes

A solid brush is a brush that has been placed into the level, and the builder brush that created it was solid at the time. When you select the properties of a brush (from a primitive) you will be able to select one of two options. You can choose SOLID which means that the brush you create is a 3D shape that has got no "insides" to it. It is a basic shape that has got an outline, but no "inside" to it. If you add a brush like this, you will add in a new section to the world, and there will be no way to get into it.

· Hollow Brushes

A hollow brush is a brush that when created, actually is an outline, and has got "another smaller shape" inside it. Thus when you add (or subtract) it into the level, you will have a shape that appears hollow on the inside. This gets hard to explain here. Let me use an example here. If you create a cube that is hollow, you will actually have a brush that is more like a cardboard box, rather then a child’s playing cube, that is entirely solid in the middle. 

· Builder Brush

The builder brush is actually the RED BRUSH that you first see as a red cube when you open the editor. This will be your most important tool when you are creating and editing levels. While it might seem a little "primitive" at first, you should find that with a few of the things that you can do with it, you will be making it into whatever you like in no time al all. If you choose to click on any of the primitives (The shapes on the toolbar to the left of the screen) then your builder brush will change to that shape, and you can then add and subtract with that brush.

This Tool, is only a temporary brush, and does not actually make any difference in the level itself. When you are "rebuilding" your level, you will find that it does not affect anything at all, as it is really only "a fake" until you use one of the other tools to make it permanent. 

· Subtracted Brush

A brush that has been subtracted will show on the editor 2D views as an orangy brown color. This has been made from the builder brush at one time, and then the subtract tool has been used, to permanently place it in the level. If this brush has been placed in an area that was solid before, then you will be able to travel into that section of the game. If you subtract a hollow brush into the game, then you will be able walk inside the brush. 

· Added Brush

When you "add" a brush into the world, you are actually creating another solid. Thus, you can only "add" a brush into the world where there is a hollow area, otherwise you will be adding something to a place where something already exists (This should mean completely useless) When you add a brush to the level, you will see it appear as a dark blue shape in the 2D views. 

· Special Brush

A special brush can be added to just about anywhere in the world. You will see them as Green colored shapes in the 2D views. Special Brushes can be used to add water, a transparent "barrier" and many other useful things, although you will most likely find these out either for yourself, or as you start reading some more of the tutorials. 

· Mover Brushes

A mover brush is a brush in the world that will actually move. This can be created by either joining a "trigger" to the mover, or by touching the mover, but that is all explained in the related tutorials. You will not see the textures on a mover in the 3D view, but only see the purple outline and there will be no way to change the texture alignment or anything like that, so you have to be sure that everything is perfect before you create it. 

Movers

Movers are brushes that can be set to move in the level, and are explained in the Brushes section. 

Triggers

A trigger can be used for a lot of things. The most common use it to activate a mover with a trigger. A trigger will appear in the editor as a black box with a lever. To set a trigger to activate a mover, simply change the "tag" of both trigger and mover to be the same. Triggers are explained once again, in tutorials, so I will not go into to much detail here, although they can be used for just about anything in your level (world). 

Intersecting/Deintersecting

You can create many things with the primitives that are supplied in the editor, although a lot of the time you find that your geometry will overlap. If you have things that overlap, you can find that your level may not rebuild properly. You can find that things will appear to have large "black" area that do not work properly. You can however use the two tools (intersect/deintersect) to make the builder brush either cut everything OUTSIDE the solid, or to make the builder brush appear only within the brush. This can be rather tricky to explain here in text without being able to show a quick animation, but what it means is that means is that your red builder brush will be "cut" to only what is either inside or outside the bushes that are in your level already. 

Rebuilding

When you have created a brush (or more hopefully ;) then you will have to compile it into an actual level. When you press the rebuild function (Either press F8, or choose rebuild from the options menu) setting it to "rebuild" will take a few seconds to quite a few minutes (depending on the complexity of the level) and it will be all ready to play. There are a few settings within the window that you can choose to either turn on or off but they are explained under their own heading, although there is a list of them here. BSP, LIGHTING, GEOMETRY, OPTIMIZATION. When you rebuild make sure that you do save the level, as you will sometimes find that there may be errors and some of the can actually crash your system. Actually it is a good idea to get into the habit of saving the level quite often and having a few little "backup" files that are kept there just in case... 

BSP

This is what will decide where the player will be able to go, and where they will not be able to go. Any SOLID brushes will affect the BSP of the level. If you have got an area that has got a large amount of adding and subtracting in the same place, then you may experience something that is called BSP holes, which appear as large black holes in your level, and most often also result in the player not being able to move through the area properly. If this is near the end of the level, or near an area that "ends" with a solid area, then you may also experience the dreaded HOM. (This is explained below). 

HOM - Hall of Mirrors

This is the bane of all editors. You will have most likely seen a HOM before, but simply put it down to bad level editing. It is - kinda. You will most often see the HOM where you have got an area or even maybe a transparent texture that is in the last place in a level. Ok, this is hard to explain, but for example, if you have got a room in the level, and there is nothing beyond the room. You would normally place a texture on the walls that is not see through right? If you placed a texture that has got invisible areas, when you try to play the level, the game engine will try to "cover" the holes there, and it does it by "mirroring" the last thing shown there. If you ever find a shimmering area where things have stopped moving and it looks bad, then most likely this is what has occurred. There is no "one way fix" to get rid of the HOM, but please check your textures to make sure that they do not contain any areas of transparency, and that in the 2D views bits of your map are not disappearing. 

Lighting

Lighting in the level is pretty basic. It simply means that you will have some sort of illumination that is in your world so that the players will be able to see where they are and what they are doing. Lighting may however take the form of many different things. The easiest way to make a light is to right click in the level on a texture (in the 3D view) and choose "add light" from the drop menu. See also Dynamic lighting. 

Dynamic Lighting

Dynamic lighting will greatly enhance the look of your level, although it may actually slow down the level, and cause some less powerful machines to drop frames. Dynamic lighting simply refers to lights that do things. You can create lights that shimmer, or lights that are spot lights and rotate, lights that pulsate, or lights that simply "strobe". There are a LOT of things that you can use, but as mentioned earlier here, they will use a large amount of resources (compared to a normal light that is) to use, and some lower end machines may suffer a large drop of frame rate. 

Geometry

Geometry refers to the actual brushes that are in your level. These are the things that your players will walk over, and also where they will be able to see. To learn how to create brushes and geometry, refer to the Brushes section of this document. 

Optimization

There are a lot of questions asked about the "Optimization" settings that can be changed within the rebuilder, although you should not actually change any of them in the BETA Editor that has been released by Epic with Unreal. I have played with the optimization settings before, and the only good that it did, was to kill my level. Trust me on this one, until there is a fix for the settings - Do NOT change them. 

Zones

Zones can be created in the editor. Zones will be able to hold specific areas in the map. A zone is really kinda like a level in itself. For example, if you have an area with water in it, it is actually a "water zone" or you can create an area with fog in it, and to make the level play faster, you can restrict the area that the fog is visible from, then create a Zone around it. This will then allow the CPU resources to be used for other things in the game (like framerate). 

Portals

Portals can be created in the level, to allow players to simply "walk" (or fall, or fly or whatever) from one place in the level, to another place. These have a nice tutorial written on them, so I will not go into too much detail here. 

Textures

Textures are simply images that are used to "paint" the brushes in your level with, so that people can actually see what is stopping them from going forward, or what is stopping them from falling through the ground. 

Wave or .wav

This is a format for storing sound. It is the basic format that most people use to import sounds into the game and then save them for use in the levels. Wave files can be explained much more thoroughly in the Booklet of your Sound-Card, so I will not explain them here in any more detail. 

Texture Packages or .utx

These are simply files that contain many images for use as textures in the levels. There are tutorials on this site, that will explain how to create texture packs and how to import files into the engine for use. 

Scaling - Textures

When you have a texture on the brush, you can actually change the size of the display. If you have an image that is too large, or small for the brush, you can actually change the scale in which it is displayed. 

Scaling - Brushes

Brushes just like Textures can be scaled to change the size of them, however, if you want to create a mover from anything, you CANNOT (and I can't stress that enough) used scales brushes during any part of the construction of the mover. If you do, everything will appear to be fine, until you actually try to use the mover or try to walk up to it. At this point, you will find that the brush that was scaled, will actually still be "unscaled" even though it may look like everything is fine. 

Skybox

The skybox is the part of the map that is displayed whenever there is a texture 9or face of brush) that has been set to "Fake Backdrop". This is most useful when you have to make a "sky" or a background that you want seen from any part of the map. 

PlayerStart

A PlayerStart will be the place in your level that the player begins when you start the level. These can be placed just about anywhere you like, although it is a good idea to make sure that they are not in a place that the player can get hurt immediately.

PainZone

A PainZone is an area of the map that is zones all around, and when the player walks into it, they will start losing health points. This loss of health will continue until the player either leaves the pain zone, or dies. Water is actually a PainZone, although there is a delay in it. The delay is there to allow the player to use the air in his/her lungs (i.e. hold their breath) and when they start running out, they will start to lose health. 

KillZone

A KillZone is quite similar to the above zone, although rather then just making the player lose health slowly, they are actually killed in the spot. It does not make a difference if the player is in GOD mode or not. They will die as soon as they step into a KillZone. 

Frame Rate

Frame rate is really simple. It refers to the number of frames that the computer can show in a second. The higher the number, the smoother the display will be. To try to improve your frame rate on a level, make sure that there are as few a number of brushes and as few a number of Dynamic lighting as possible. There are a large number of influences that will determine the framerate, but generally speaking, try to use as little "goodies" as you can, and the level will play better.

The Buttons

By: Millennium 2002 and KarB

Dated: 11/8/98 

Introduction:

Before I get to all this, I will explain how the editor works (well a little of how the editor works). When you first load it - before you make ANY changes to the map, you actually have a HUGE solid cube. You then actually "carve" you world out from this cube. When you first start, there is simply solid "void". As you start to carve your level out, you can then place brushes back into the world by adding them, which makes their insides go back into the solid "void" that you started with...

Basic Building Brushes:

[image: image2.jpg]


 Add brush to world

This button is used to "add" a brush to the world. Any brush can be added to the world, but make sure that you don't try to add something to a piece of the world that is already solid, as this can turn out quite nasty when playing the game or rebuilding...
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 Subtract brush from world

This button will "carve" out the brush from your level. Do not try to subtract a brush from an area that has already been subtracted - as this won't work and can have adverse (bad) effects on your level.
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 Brush intersection

This is the "intersect" button. It is used to change your brush. Say you have a "cube" brush, but only want to cut out half a cube from a solid wall. You could go through the cube properties and change the shape of your brush, or you could simply move the cube to where you want it to go and then press this button. This will make a new brush for you - but it will only be where the solid wall was before. It is also good for making complex objects into a single brush. Say you want to make a fireplace, and you want to use it in a few places - create it (bit by bit) and then place a cube brush over the top (so the cube {or whatever} encompasses the fireplace totally) and when you press this button, your new brush will be EXACTLY the same as what you created using many little bits.
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 Brush deintersection

This does the opposite of what the intersect button does. It will select the parts of the brush that are in an area that is not solid - and create them into a new brush for you.

[image: image6.jpg]


 Add special brush

This allows you to create "special" brushes to your map. These can be a wide range of things, such as windows, water levels, portals and the like. It is normally used in combination with the "sheet" brush.
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 Add movable brush

This button will create a mover for you. It will use whatever brush you have currently selected. When using this brush however, make sure that the brush you have selected has NOT been stretched in any way, as it won't work properly...
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 Build a cube

This will create a cube brush for you. If you right click on it, it will give you an option to go to cube properties. This will allow you to change the height, depth etc of the cube brush you will create.
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 Build a sphere

This is the same as the cube, but it will create a round ball shaped (well a sphere really) brush. Once again right click on it to alter the properties of the brush.
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 Build a cylinder

This will create a cylinder for you, that you can use like any other brush.
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 Build a cone.

This will create a cone (rounded pyramid) that you can use like any other brush.
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 Build a stair

This will create a straight flight of stairs. These stairs will not turn or curve as they go up.
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 Build a spiral stair

This will create a rounded set of stairs that can be set to form a very tight spiral staircase.
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 Build a curved stair

This will simply create a rounded set of stairs that are similar to the first set, but they curve around to a side when they have been built.
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 Build a sheet

This creates a 2 dimensional sheet. It can be used for a VERY LARGE number of applications. One of the most common is to create a water plane. This tool does however require more practice then the other brushes, as it is not a 3D brush and can easily "wreck" a level. It should NOT (I can't stress this enough) be used to create walls and other solid shapes. (Well at least until you are quite familiar with the editor).

Advanced Building Brushes:
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 Move camera

This is the normal view button. It is normally toggled to "on". It lets you move in the views. My advise is to leave it set to what it is...
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 Zoom camera

I can honestly say I have no idea what this button is supposed to do. I have tried it a few times, but normally end up miles away from where I am building, so I always leave it set to the button described above.
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 Rotate brush

This button is used to rotate the brush that you have currently got selected. It is used by holding CTRL and with a combination of mouse buttons (Left rotates X axis, right rotates Y axis and both rotate Z axis) allows the brush to be rotated to any angle.
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 Sheer brush

This brush allows you to "skew" the brush. That is, it allows you to 'lean' the brush to a side.

[image: image20.jpg]


 Scale brush

This button will allow you to change the size of your brush. That's right, once again CTRL and the mouse will activate it when it's selected. 
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 Stretch brush

This will alter the size of your brush, but it will do it one axis at a time. Which basically means it's great for adjusting something that is almost perfect. 
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 Snapscale brush

This button will allow you to stretch a brush along all three axis' , but at the same time it will "snap" to the grid. This is VERY handy to enlarge or shrink brushes, as they are easy to match up later.
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 Select all polys

This brush will select ALL the things in your map. I don't know what the point is, but the option is there...
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 Select all actors

Once again, I am not sure. But look on the bright side, I haven't used it - and still made great maps, so it probably (feel free to prove me wrong) isn't all that integral to the editor.
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 Select actors inside brush

This is another of the buttons I haven't used very much - or at all. I can't really tell you what it is used for...
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 Select none

This will make sure that "none" of the brushes or textures are selected. In a way, it unselects everything...
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 Invert actor selection state

This button will replace the selection that you currently have. Sorry I can't say more, but yet again, it's a brush that I have little use for. 
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 Replace selected brushes.

This button will replace the brush with what you currently have selected.
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 Replace selected non-brush actors

This button will replace the actors selected with what you currently have selected.
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 Undo last operation

I don't think that anyone there needs a detailed explanation of what an "undo" button does, But on that note - just remember that you can't undo past a rebuild. I mean that if you rebuild your level and don't make any changes - then you won't be able to undo something that was changed before you last rebuilt.
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 Redo operation

If you accidentally pressed "undo" once too many, then this button will redo the last action that you undid
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 Pan textures

This will move the texture that is selected. It is used mainly for aligning the texture to match up with other textures. If you have more then one brush with a texture, and you want them to line up - then this is the tool for you
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 Rotate textures

This button will allow you to rotate a texture so that it matches the direction of other textures - or simply faces the direction that you want it to face
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 Drawing region: Selected actors

This button will "hide" all the brushes that are in your level. It's great for adding in detail and things like that when you don't want to see all the other brushes
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 Hide selected actors

This button is similar to the one above, but it will only hide the brushes that are selected. You can select more then one brush at a time to hide by pressing CTRL and select as many as you like
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 Drawing regions: Off

This will "bring back" any brushes that were hidden using the buttons above.
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 Drawing regions: Brush Z (depth)

This will hide the Z axis apparently. I can put this into the pile of buttons that I never use

Toggle vertex snap. This will toggle the grid snap function of placing brushes. It is generally used for adding the details when the grid is in the way... 
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 Get help

Well, now here is a useless button - as you are probably using the BETA UnrealED, this button has absolutely NO function whatsoever, so don't bother trying to find the help file...
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 Camera speed

This will change the speed with which your moves brushes and other objects in the views
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 Toggle grid mode

This button will snap objects to the grid when they are moved around in the editor
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 Toggle rotation grid

This will toggle whether you want rotational grid snapping. This button makes it rather difficult to rotate a brush when it is large and also makes it difficult to align things to angles made by sides of cylinders for example, but makes it a LOT easier to align general angles in the editor

Basic Construction Phase One

By: Millennium 2002

Dated: 8/8/98

Introduction:

When you have loaded UnrealEd you will see four main windows, a few buttons to the left and some textures* to the right. You will also see a red cube in the lower left window. Before we go there I will however explain what the views are. The top left view is the "Top Down" or overhead view. The top right window is the "Front" view. The bottom right is the "side" view. Finally the bottom left is the 3D view. The 3D view is movable to any angle by the mouse. I will start with the absolute basics. 

View Movement:

To move in any of 2D windows, simply press and hold a mouse button and then move the mouse. To zoom in and out, hold both mouse buttons and move the mouse up and down. The 3D window is a little more complex. Holding down the left mouse button and moving the mouse will move forward and back, and turn left and right. Holding the right mouse button will move forward and back and strafe left and right. Holding both buttons down will move you up and down, and strafe left and right. 

Making the first room:

[image: image1.png]


Right click the cube button* (This brings up a menu), and select cube properties. There you will see five places where you can type. In height field enter 256. (It should be defaulted to this anyway). In the breadth field enter 512, and 512 again in the width. Now press build (you can shortcut this by pressing the "enter" key.) In the 3d view, you should have seen a change. Now go over to the textures toolbar (the one on the right) and click on load. This will bring up a load box with many files in it. Select "Ancient.utx" (One of my favorites) and when the file has loaded, scroll down the textures bar until you find a good texture for a wall and select it (Single click the texture). When you are happy with the Texture, hit the "subtract" button*. You should now have brand new room in your level. Now in the 3D view, highlight the floor (single click on it) and find a good texture for the floor (try the drop down list for "floor" textures - see textures drop down lists*) and single click it. This should give you a nice Floor. Repeat the process for the ceiling (once again, you can use the "Ceiling drop down list" from the textures). You should have a good looking room now. 

Adding the light:

We need to add some light into the room to make it playable. In the 3D view, make sure you can see a corner near the ceiling somewhere and right click it. This will produce a menu - select "Add Light Here" and you will see a flaming torch added to your room near where you clicked. (Have a look at the full lighting tutorial for more info on lights and stuff - but do that later!). Now place another light in the other corner of the room and you should just about be ready to rebuild* - but there is one more thing that is missing, a place for your player to start.

Adding the Player Start:
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Go to where you see "textures" at the top of the screen to the right, and select "classes"* from the drop down list. This should bring up a list of things with a line in front of them. Single click on the line in front of "navigation" and you will bring up a list nested in the first one. Select "PlayerStart"* and in the 3D view, Right click on the ground where you want your player to start. Once again you will see a menu come up - this time select "Add Player Start Here". You should now see a little joystick placed on the floor of your room. Now you are almost ready to play the level, just ONE more thing.

Rebuilding the level:
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You now have to "rebuild" the level and this is !!VERY!! important. Press F8 (this sometimes seems to do nothing - if this is the case, then go to the top menus (File, edit etc) and select "Options" then "Rebuild" and make sure that the "autoBSP" is checked ( I'll go into this in a later tutorial) and press rebuild. 

Saving and playing the level:

Well, after all of that these are a piece of cake. From the "File" menu, select save and give it a name, then when it has finished saving, select the "file" menu again and choose "Play Level" this should now bring you into the game from a players view. That's it, You have now created your first level, Sure it not much yet, but you now have an idea on how the very basic UnrealEd works. Check out my next Tutorial named "The Basics Phase Two" for more.

Basic Construction Phase Two

By: Millennium 2002

Dated: 8/8/98

Introduction:

Now that you have a basic room and a player start, you will want to make more rooms and the like for it (otherwise, lets face it, it will be pretty boring...)

Adding another room:

To create another room is just as easy as making the first. Once again, right click the "cube" button and select the height, width and depth of the cube you want to create, but this time place it just off to the side of the first room that you created, say about half the size of the room away... If haven't moved a brush* (the red wire frame of the cube) yet, it is simply done by holding down control and moving the mouse in one of the 2D views (on this note, make sure that the brush is selected, by clicking on it - if it's not already highlighted). When you are placing the second room, make sure that the floors are on the same height (The brush will move up and down if you have changed the height of the new cube you created) and then once again hit the "subtract" button. Now that you have a second room, play with the textures - maybe continue the theme of the first or change styles entirely (this can easily look bad though - if the change is too drastic) and place a few lights into the room.

Joining the two rooms:

[image: image54.jpg]


Now that you have the two rooms, you must have a way to get from one to another. There are many different ways that this could be done - teleporters, portals and the like, but let's just use a simple hallway for now... Right click the cube, select properties, and then make it narrow (128x128 {height & Width} perhaps) and make it LONGER then will be needed to join the two rooms - but not long enough to reach the opposite side of either room. And place it between the two rooms. Now press the "deintersect" button (the one just below the subtract" button) and you should find that the hallway has been cut off where it meets the room walls. This will make sure that the hallway lines up with the walls and does not overlap anywhere (you can actually cut out something if it is bigger i.e. overlaps, but it slows down the game, rebuilding time, and is bad designing - lets not get into bad habits straight away eh? ). Change the textures if you need to and do the lights. Now I personally like dark hallways as they look great with just a little light spilling over from the rooms on either end - it adds to the whole atmosphere of the game, but if you want to add lights to it, the please do so…

Adding the light:

Now you are ready to rebuild again, and do so (if you don't you won't be able to play properly...)

Saving and playing the level:
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Okay, now you should have a small hallway with two rooms on either end. Still not the !!BEST!! multiplayer map, but I will only teach you how to USE the tools in UnrealEd, not create levels (sure that comes into it, But I won't go into floor layouts and the like - unless it is a general piece of advise...). Creating levels is up to you, You now have a basic idea of how UnrealEd works.

Complex Brushes

By: Millennium 2002

Dated: 7/11/98
Complex Brush Shapes

This tutorial will deal more with the actual creation of brushes then with the implementation. Using a brush is easy, but actually creating one is a little more difficult. This tutorial will show you how to create a simple table into one brush. I will not be telling exact sizes or anything like that, but you will be able to follow quite easily.

The Table Top:

This will be the easy part. All you have to do is to create a simple cube with the size of the table that you want. Make it either square or rectangular if you like, but make sure that it is not to think, otherwise the table will look awkward.

The Legs:

The legs of the table are another simply thing to do (Do you see why I chose a table for an example now? Hehee) Make a brush that is the shape of a long piece of wood. use something that will sit under your table and then allow the table to "rest" on it when it is complete. When you choose how thick, and how high you want your table legs to be, an them in. I will be using pictures here from a table that has got six legs and is pretty close to the ground, but that is merely an example.

The Edges:

You could leave your table at that, but why not add in some edges for the underside of the table to add in that little "extra" and make the table look once more that little more realistic. Make a brush in the shape of a basic plank of wood, then place it so that each end will reach a set of legs, but no poke through into the other side of the leg. If you find that you brush is too long, don't "scale" the brush, but change the actual length of the cube that you are using. If you scaled the brush, it would later effect the textures on the brush, and that would look poor when you actually used it in a level later on. When you have got the plank in between two legs, just under the table top, intersect the brush, and then add it into the world. Repeat this process until you have got the entire underside of the table with an edge.

When you have done the steps that are written above, you will be able to create one brush from the entire table. To do this, create a brush from one of the primitive (anything, but most likely a cube brush) and make it large enough to "surround" the table entirely. (For example if you table is roughly 200 wide, 150 long, 64 high, then make a brush that is 220 x 170 x 80) and place it so that the table does not protrude from any point within the cube. Now simply press the intersect button and it will change your red builder brush into the shape of the table. You could use this brush straight away, but I would suggest placing it off to the side, and making a table there that will not be used at all, so that when you go to use the brush again, you will be able to do a simply "copy polygons to brush" and then use it wherever you like.

If you do create a nice complex brush (even if it is quite simple) please send it down to Unrealed.net so we can post it here and let everyone use them. If you would like to save your brush at this point, make sure that the red builder brush is the shape of you table (or whatever you built) choose the brush menu and select "export brush". This will then give you the option of exporting and saving the brush.

Vertex Editing

By: Mark Poesch

Dated: 22/6/98

Within UnrealEd, select a wireframe render mode, or use a window already in wireframe for vertex editing.


Select the brush to modify by left clicking on an edge (this will allow you to see the current pivot point).


Select the desired vertex with a left click (right clicking will select the vertex, and snap that vertex to the grid -- moving the entire brush relative to the vertex).


With the target vertex selected, hold the Alt key, the left-click-and-drag the vertex.

NOTES:

Grid snapping behavior is still not consistent - turning off the grid-snap, selecting the vertex, then turning on the grid-snap, then moving the vertex usually works when nothing else does.

Vertex editing will snap to adjacent vertices - this is intended. Unfortunately, there is no good way (currently) to separate the vertices once they're aligned. (Vertex editing affects all vertices within the SnapDistance radius simultaneously.)

A "too few vertices" error can cause the editor to crash if too many vertices are edited into the same plane.... I wasn't able to track down the bug before Unreal shipped. Sorry.

The current implementation of vertex editing is not production quality (hey! I got it working in less than four hours. :) Make sure you save your work before you use the feature.

Mark Poesch

Legend Entertainment

Natural Landscapes

By: Millennium 2002

Dated: 25/11/98

Natural Landscapes

Natural Landscapes seem to be what everyone wants to do when they are creating an outdoor level, so I best be having a little talk here and talking about some of my own methods of achieving a good looking level. I do have a few tricks here that I will explain, but a lot of it is simple technique that has been used and grown from simple editing. I mainly use a technique that grows slowly using the basic primitives and then manipulates the brushes, and adds in more brushes until slowly the main object that we are trying to create grows to look natural because of the irregularity of the brushes, then once that has been done to a level that we are happy with, an intersection of the entire brush will be made and the new builder brush is used to create a realistic looking mountain or cavern or whatever in the place where we want it.

To start with I think that an example of how I created a damn good looking cavern will do the best job of explaining all the rambling that I have done so far. I needed a cavern to look like a natural cave in one half of it (The level is actually for the up and forthcoming Minions of Evil TC). I needed a cavern with a realistic looking rock-fall and a waterfall flowing over the rocks and into a nali-made pool of water. I started off deciding just how big my room would have to be, then added a little "play" on each side so that I would be able to add in extra crevasses with a realistic amount of ease, rather then toying with additional brushes that would have to be subtracted. When I had decided upon the actual size of the room (about 1024x2048x1024 if you are really interested) and I made this room off a little from the level. This was then where I was working the most with all the additional brushes that I would be using. It is much better to create something like this off from where it will actually be going, as it then allows you to "test it out" by doing an intersection and putting it into the level before you have to delete any of the older brushes. Ok, getting back to where we were. I then created a few "base" brushes. I wanted the rocks to look as natural as I could, so I made a basic cube brush, then intersected it against the wall of the room, until it looked fairly realistic. This was actually fairly easy, as I simply rotated the brush so that all the main angled sides were overlapping against the wall, then did an intersection to get rid of it, and rotated it some more, then did another intersection and so forth, until the brush no longer looked like a cube, but a boulder. When it did look like a large rock, I put if off to the side, and added it to the world, so that it would not go anywhere and I could use it over and over again if need be. I then made another cube and followed the steps above until I had another boulder although I made sure that it looked different to the first that I had made. I kept this up, until I had made about four or five (I can't remember exactly how many) and they were all sitting nicely off to the side of the room. When I was satisfied with what I had for base brushes, I "drew" the entire inside of the cave inside my head.

Then with the brushes that I had made, I started to build the cave little by little, and made sure that I intersected the brushes EACH time before actually added it to the world. This was quite important, because if you didn't do this, then you would actually be causing horrible BSP holes (If you are not sure what these are, please look up the Jargon tutorial) and then most likely create a HOM effect. Slowly as each of the brushes was added, the cave interior was beginning to look more and more like a real cave would look. To stop the repetition as I was only using a few main brushes I was rotating the side that would be visible all the time, and also changing the size of the brushes so that if I did have the same faces of the brush showing, I would not have them the same size as well. Even though this was fairly tedious and did take a long time for it to be as good as I wanted it to be, the final product was nothing short of "real". When I had finished creating the actual rocks that would make the "fallen in" section of the room, I was ready to start adding in the pool and the water. Using the 3D view of the editor, I made completely sure that I would have no holes in the bottom of the pool and the sides of the pool, so that I would be able to create a sheet of water, and safely place a water zone below it. I had to "patch up" a few holes that were there, and I also made (I got a little carried away here, and I admit that freely) a little rock fall or "rapids" for the water to flow into, then finally I made sure that the "water level" would be as natural as possible by adding in a few extra rocks to make sure that the pool would look as natural as possible. When I had made the actual sides and interior of the pool, I added in the nali-made pool edge, which was made from a cylinder (I think about 40 sides) and hollow. I made it to be an elongated shape by simply stretching one plave of the shape so that it would grow longer, but nothing else. When I had the right shape built, I intersected the brush and found that I had the brush just to the exact dimensions so that the water would flow easily and freely into it like a real water would flow. When this was complete and I had the brush textured and just what I wanted it to look like (still without a drop of water though) I did an intersection of the entire room, and placed it into the level where it was supposed to go. I then saved the level ( Something that you should do as often as possible) and started to work out how to create the water itself.

Who ever said that water had to be made from a sheet? I think that this is a great misleading theory that everyone seems to have. I actually used a cube and like I was making a boulder, slowly intersected to and from the brush until I had the red builder brush looking just like the water would look when I had finished. This was done in a few steps, as it was simply too much work to create the entire brush from a single brush, so I made a few brushes and created them in a way that they would overlap each other, and the player would not be able to see where any of them did actually meet. The fact that I was using a solid brush here also made the job a lot easier as it allowed me to work within a finite space and not work with a sheet that would intersect poorly, if not all the edges were surrounded. I finally managed to create the brushes that would make the water and placed them into the level just like I would place water normally. I prefer to create water so that it actually flows, and so I went to each individual facet of the water, and made them "flow" downward, even though thus did take a lot of playing about and changing the individual directions of the faces and changing the panning scale. Finally when they all looked good enough so that I would be happy with them, and then I placed in the water zones where I knew the player could reach without cheating. I actually did leave a few places there that were not filed with water, but this was simply because it would not be possible for the player to get to them and so placing water into them would simply add to the resource list that would have to be filled, and it would slow down the level just that little bit more.

Finally I added the lighting to the cavern and did a final rebuild and then cavern was complete. There is no "one" way to do natural landscapes and rocks, but this should be a good and reliable way to create very realistic looking rock formations that will look really good in your levels. If you want to add to this tutorial, then please email me, and I will happily add useful comments to this, and there is simply so much to cover, and what I have done here is simply one method of doing rocks.

Out Door Techniques

Many people want to create out door levels, and I have recently posted a few tute's about how to create them, but I have not really explained what you should keep in mind when you are actually creating them. It is a MUST to remember that you have to keep your levels as low in polys as you can. Let's face it. Yopu might have a PII 450 with 256 Mb ram, and all the attachments that go with it, but not everyone has got that type of PC at home, and certainly not everyone laying Unreal has got a 3D Card to go with it either. If you wanted to follow the guidelines as set by Epic in Level design, you would never have more then 150 polys in the players frame of view. Now I personally do go over that limit, bet certainly I try not to go too far over it. Let me use an little example here. I was doing a small village in a large outside area, and the village was visible from the outside, I first create the houses. I made them to look nice, but simple from the outside, and then spent a large amount of polygons on the inside of them so that when a player walked inside, they would feel like it was really a nice hut, but the outside of the house would not slow down the frame rate too much when a player saw the entire village from afar with a few houses there.

If you are doing large vast areas, and you want to have the next best thing to a plain there, why not create a fairly basic plain, and include a few little bumps here and there, but do not try to make the entire landscape bumpy and mottled. Doing that might look very nice, but if I was to try and play it on a smaller PC perhaps a P200 without MMX or 3D Card then I would think that it is a really hopeless level. It doesn't matter how nice it might look if it is unplayable for people.

Cut things off. If you can, include a few larger mountains or fences or anything like that that will help to break up the level. You can have as many polygons as you like - Just make sure that the player cannot see all of them at the same time. You can have a maze that has more polys then a natural sphere but you simply have to limit how much the player will see at one time. Have a look at some of the inside levels in Unreal. You will find them to be quite detailed. There is a lot of intricate little things inside each room, and the entire levels are generally very full of cool little things to play with and gawk at. However now take a look at some of the outside levels, and see if you can find anything at all that will make the level slow down at all. The levels are almost bleak although due to the design of them, they still look great. If you remember the first outside level, the one with the nice falls and the outside of the spaceship etc, then you will see that the level is in fact very bleak, and simple on the outside, but as soon as you start going on the inside of the mines there, the geometry used suddenly gets a lot more complicated and "Eye Candy" intensive. This can be done as you will still have a much smaller limit of polys that you can see in the level at one time. The same thing with any level really. If you can hide all of the complex geometry to a smaller area where the player can only see a set limit of polys at a time, then it will not hamper your levels playability and you can go to all sorts of lengths to create great eyecandy and graphic feats.

This tutorial may seem like a lot of rambling really, and as I read over it, I am wondering if I should post it at all, but I guess that it will help some people out there, so it may as well go up

The Floor Lofter

The floor lofter can make a great difference to your levels. It is actually a great little device that I have not used to much before, but the other night, I started to fiddle with it and managed to get some terrific results from it, and I have had quite a few questions about natural levels of late, so what better way to show you how to do them, then with a good explanation of the Floor Lofter.

The floor lofter can be accessed by a menu from the "window" option, and it opens a new little window. When you open the window, you will see a "box like" frame of a brush, with five dots on the top of it. There are a few other things here as well, but these will be explained in order in a few moments. You will see five dots. Each of those spots represents a different level that can be changed to suit your needs. The best way to explain how it woks is to pretend that the whole thing is a cake for a little while. You will be cutting the cake into a few separate slices. The first bit that you are looking at is the end of the cake side on. You can change the height of the "topping" here by moving the dots up and down. When you have created the first layer of the cake then you can start to move on to the second section of the cake. At the top of the screen you will see a section that says 1 of 5. and there will be a few arrows next to that. Click on the right arrow and you will see it click over to 2 of 5. You will find that the dots have moved to the middle again. To start making your second section of the brush, move your dots up and down again, and you will have created the second section of the brush. Keep doing this until you have got all of the parts (There are five in total) and click on the "create" button. You will see the new screen close, and your builder brush will be in the shape of your new creation. The brush will be in proper 3D and will be able to be used just like any other brush in the editor.

Note:
You can create a brush that is much taller then the normal one that it will automatically create by dragging the bottom of the brush down, and you can actually drag the dots up over the limit of the screen that appears. You are also able to create brushes that will match one another by writing down the vectors that the dots take. You can find these out by letting the mouse hover over each one. To make a longer brush, simply make sure that the 5th line of you first shape and the 1st line of your second brush are set to the same numbers. The same can de done if you want to have a brush (or landscape) that is wider then the standard that the brush is. You can actually change the size of the brush that is created, and you can then scale the brush up and down when you take it back into the editor, although if you scale it up, then you will obviously lose the detail in it, so you might have to do a little math to make the brushes align properly when you get them back into the editor.

This should about wrap it up here, although as I said, I have really only used it in the last few days, if there is something here that I have not explained, then please write to me, and I will try to make things a little clearer, or if you want to add to this tutorial, then please feel free to do so. 

Basic Mover Overview

By: BEG

Dated: 1/6/98

Procedure:

1. Build your rooms, hallways etc. Place your lights, playerstart and other actors.


2. Create a separate room somewhere away from your level.


3. Build your doors, lifts, etc. like you would any brush. This will act like a template for your mover.


4. Texture your "template" how you want your mover to look like.


5. Use your red builder brush to encompass your template brush and Intersect it. (See notes for warning)


6. Right click the red builder and select Copy Polygons -> To Brush. This will copy the texture from your template and ultimately to your Mover brush.


7. Align your red brush into the world where you want your Door, lift, or whatever into your world.


8. Click on the Add Mover button. Your mover is now in place and ready to have its keyframes set.


9. Move your red mover out of the way so you can see your Mover(Purple brush). Left click to select the mover. Right click Properties -> Mover Keyframe -> Key 1. Move your Mover to where you want it.


10. Right click the mover and go to Properties -> Mover Keyframe -> Key 0(Base). This will reset it back to its original position


11. Rebuild your level and test it out, you should now have working and textured movers in your level. 


BEG's Words of Wisdom:

Movers are very integral to every level, you will be able to add doors, elevators and other goodies you can think of. Watch for my upcoming Advanced Movers tutorial for Complicated doors, multiple keyframed movers, and maybe some other tricks. Movers can also be used in combination with Triggers(see Trigger tutorials) for even more cool things your can do with Movers. 

Notes:

Before your intersect your "template" brush make sure you reset the scaling on your red builder(Brush | Reset | Scale). If your red builder had been scaled previously it will cause clipping problems and your player will slip through your mover.

Moving Doors and other Movers

By: Millenium 2002

Dated: 9/8/98 

Introduction:

I will be starting with simple mover (A door I think) and going on to more and more complex things. I would expect that you are quite familiar with UnrealED to complete this tutorial entirely, but if you just want to know how to make a door move; then this will also help you out. Feel free to stop when I have reached the level that you want to go to... 

The starting point:

You can do this in a level that you have already created, but I would ask that you spend the time and just start a new one for this tutorial. This way, you will be able to follow my instructions easier - and you will repeat the doors when you go back to your own level, further imprinting it in your mind. 
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The room:

Let's make a room that is fairly large. Create a cube 256x1024x1024 and make it look like a room (Textures, PlayerStart and lights etc). When the room is complete, make a cube 256x1024x32 and place it in the middle of the room to make two rectangular rooms. This will form the basis of the tutorial. Now in the middle of the wall (At floor level) create a cube 128x128x32 and "subtract" it from the wall. This will be the doorway. 

[image: image57.jpg]| Zonelnfo

bDestuetive Fabe
bFogZone False

bGravityZone False

BKione Fabe

bNeuraone Fabe

bParZone Fabe

BateZone Fabe

DamagePese |0

DamageSting

DamageType None

Entryctor None.

EnSound None

Exiticor None “The sefting
ExiSound Nore

ManCarcasses |3

ZoneFlidFioton | 1.200000

+ZoneGravity %=0.000000f#0.000000 Z=-950.000000)
ZoneBroundFicion | 1.000000

ZonePlayeitvent | Nore

ZoneTsg None

ZoneTerminalVelosity | 2500,000000
P 000000.Y=0,000000.2=0,000000)




A simple swinging door:

To make the door move, we have to create a mover; so here are the steps. Firstly create the door with a cube (128x128x16). Make sure however when you are creating the door, that you create it in the MIDDLE of one of the rooms and in the air (as opposed to in the doorway). When you have made the door, make sure that you are happy with the textures, the texture alignment, scale and the like as there will be no way to change them later. 
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When you are happy with the way the door looks, make a brush that is bigger then the door (150x150x100 for example) and place it around the door (make sure that the new brush completely covers the door) and press the "intersect" button. 
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If you are not sure at this time, check out my buttons tutorial and come back. When you have intersected the door, move your new brush to the doorway, and place it where you want it to go. Now click the "add mover" button. Move the red brush away from the door (it will only get in the way) and select the mover (Left Click). Once it is highlighted, right click on it (making sure it is the only thing selected) and select "Mover Keyframe --> Key 1". Now rotate the door to an open angle and make sure the hinges are still close to the wall, right click and select "Mover Keyframe --> Key 0" At this point your door should move back to the doorway. You should be ready to try it out now. Rebuild the level and have a go... 

Sliding door:
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You will at some time want to have a sliding door, so let's get into it... To build a sliding door is actually easier in a way, then a swinging one. All you have to do is create the door as detailed above (i.e. NOT in the doorway) and when you are happy with it, intersect it with a larger cube. When you have your new brush, move the brush to where you want the door to slide into (Not in the doorway, but actually in the wall (at this point you probably should lower the grid size. If you haven't done this already; simply Right Click in one of the 2D views and select "gridsize" and then maybe one or two). Now make sure that the new brush "touches" the wall that the door "attached" to. When placed, subtract the brush. You should now have a hole in to wall just to the side of the doorway. You can change the textures if you like, but if you do it properly, then these textures will never be seen anyway :) Now move the brush to where you want the door (This should be just to the side of where you cut the hole just earlier) and click the "add mover" button. Get the red brush out of the way, then select the mover itself (It has a purple outline) and right click it. Select mover keyframe--> key 1. Now move the door into the hole in the wall and right click it again. This time select mover keyframe--> key 0. Your door should move itself back to where you originally placed it. That is all there is to it. Rebuild the level and try it. 
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Automatic doors:

You should notice that the door work quite well, but you actually have to run and "bump" into them to open them. It would be much better if they just opened when you ran "near" them wouldn't it? The first thing you will have to do is add a trigger. To do this, go to the "classes" menu (it's right next to "browse" on the right of the screen) and select "triggers" from the bottom of the list. Expand the section and select "trigger". Place the trigger in the map (Do this by right clicking in the 3D view and select "add trigger here". When you have the trigger where you want it (it should probably be just in front of the door), and select it. 
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Now right click and select advanced properties. In the advanced properties, choose "events" and change "event" from none to "firstdoor". When you have done that, click the door again (The mover actually) and right click it. Select "advanced properties" and go to "events". Change the "tag" from none to "firstdoor". Now this is important, go to the "object" section and you should see a entry named "initial state" this is set to "bumpopentimed" by default. Change it to "triggeropentimed". This is important because even if you have a trigger made for the door (or any mover for that matter) it won't be effected by the trigger until you let it be "triggered" (sorry for the pun, hehehe). At this point, you could rebuild and try it out, but before you do that I will make you do one more thing. Left Click on the trigger (to select it) and press CTRL W. This will create another trigger exactly the same as the one that is there (you can duplicate almost anything using this) and place it on the other side of the door. If you didn't do this, you would have a door that only opens from one side - which is fine if you want to "trap" a player in a particular area, but we don't want to do that in the tutorial... Rebuild and have a go. 
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Doors with sound:

All this should be pretty cool huh? But our doors need to make all those cool sounds that doors make, right? (If you disagree - then the end of the world will occur and all my work will be in vain. OOPS sorry, I forgot where I was :) Where was I, Yes doors that make sounds. Select the door and bring up the advanced properties. Bring up the "mover sounds" and select "ClosedSound". You should see three little dots in the same cell. Click them and this will bring up the "sounds" menu on the right hand side of the UnrealED window. Click the "load" button below the main sounds toolbar. If you like a ancient or fantasy setting choose "DoorsAnc" or if you like a more futuristic feeling, choose "DoorsMod". You can play a sound before you set it to the mover by clicking the sound in the "sounds toolbar" and pressing "play" at the bottom of the toolbar. When you have found a sound that suits your needs, press the "Use" button which is located next to the three little dots (in the advanced Properties window) and this sound will be set to the door when it closes. Please Repeat the sound for the "opening Sound" and we should be able to have a go and play the level. Rebuild it and let's have some fun.

Additional Notes:

By this time, you should have noticed that the doors we made are simply made from "movers" not a special piece called "moving door" or something like that. Doors are in no way different to elevators or anything else that moves. By now you should be able t replace the stairs in your level with movers and make the level much more animated. If you would like to know something n particular about doors or how to do something with movers, then contact me at the above address. I think that doors are quite important in a level, so I will go into more (yes that's right, MORE!) depth with doors in a later tutorial, but I think that this will keep most people happy for the time being... 

Iris Doorways

By: Millennium 2002

Dated: 25/8/98 

Introduction:

I will create a simple room, then build a wall to "cut" it in half. This will then allow a doorway to be made. The doorway will be edited, then finally the "Iris Door" will be placed into the doorway and made to move...

The room:

I will only say that the room I have created this door in is 256x512x512. The textures are up to you, although with doors like this one, a futuristic theme certainly adds atmosphere. The wall placed to "cut" the room in half is 32 thick (Note this as, it !!HAS!! to be otherwise the doorway will look horrible).

Creating the Doorway:

[image: image64.jpg]


The hole for the door is simply a "Cylinder" on it's side, (Height 32, Radius 128 - This will make it "touch" the floor and ceiling.) Make sure that the hole sits either on the floor and ceiling, or has a "ledge" within the wall for it to "touch". (This is a little hard to explain, but I think most of you get the drift.)

The doorway:

I think a little explaining is needed here, so I will give away trade secrets and tell you guys how these doors work. It is simply made up of multiple movers that respond to one trigger on each side of the door. Now for the next step, you will need to create the same cylinder (only this time make it 16 tall - which should make it narrower then the doorway you created earlier) either off to the side (or best of all - just outside your level). When you have created the Cylinder (textures are not important at this point) move on to the next phase...

"Cutting" a segment:

[image: image65.jpg]


Now that we have our doorway cut out, we need to create some movers to fill it back up again... Create a "Cube" brush (Make it about 256x256 but make it 8 wide) and place it over the "fake" doorway you created off to the side. Now align it so that you get a quarter of the doorway and "intersect" it.

[image: image66.jpg]


Now place this new brush NEAR the doorway, but make sure it floats freely (i.e. - make sure that it doesn't touch the floor, walls or ceiling) and "add" it to the level. You should see a little segment of your doorway there now. Make sure that the correct texture (scaling, alignment etc) is applied to the segment, and finally "intersect" the segment (Once again with a brush that is larger than the whole segment to ensure it is done correctly (This is why you had to make sure the segment doesn't touch the walls, floor or ceiling etc earlier). When you have your new brush, move on. 

Creating a mover:
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Now that you have a nice little segment of the doorway, place it inside the doorway (Inside the actual level) and align it to sit just touching the walls. Make sure the innermost point is in the middle of your doorway.

[image: image68.jpg]


This image is the "Side On" view of the segment being placed. 

When you have placed it just right, click the mover button. Don't change any setting yet, but rotate the ORIGINAL brush 90 degrees, and move it so that one side touches the mover you just created and the other sides line up with the walls around it.
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When you have done this, create another mover and repeat this process until you have all four quarters of the door made into movers.

Cutting another segment:

[image: image70.jpg]


When all four Segments are in place, go back to the "Cylinder" that you created off to the side, and "Cut" another "Segment" from it, but this time make it at a 45 degree angle to the first segment that you made. (If you are not sure what the heck I mean, Have a close look at the Images supplied)
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When you have cut another quarter of the doorway, repeat the process above and create the second layer of movers in the doorway. These should be placed to just touch the original set, but not sit inside them (Once again, look closely at the images). When you have placed all four - once again, 90 degrees rotated each time - move on to the next section. 

Setting the movers:
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When you have the eight mover placed nicely in the doorway, select ALL of them at the same time, and bring up the advanced properties (Right Click – but you should already know that) and select the "Events" section. Name them to something like "IrisDoor".
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Then select the "Object" section and change the "Initial State" from "Bump Open Timed" to "Trigger Open Timed".
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You should also change the time that your door takes to open (After all this work, you want people to admire it - don't you?). This is done in the "Mover" Section and the entry to change is (surprisingly) "MoveTime" Change it to about 5. You can add sounds to these if you like (Check out the Intermediate Tutorials - under Doors and Movers - if you aren't sure how), but we still need to add in a trigger. Select "Trigger" from the classes menu (Nothing special - just a plain old trigger) and place one in front of your door (The 3D view is probably the easiest). Select the trigger (Only the trigger) and go to the "Events" section and change the "Event" entry to "IrisDoor". Don't Forget to place one on each side of the doorway...

Setting the Trigger:
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Select "Trigger" from the classes menu (Nothing special - just a plain old trigger) and place one in front of your door (The 3D view is probably the easiest). Select the trigger (Only the trigger) and go to the "Events" section and change the "Event" entry to "IrisDoor". Don't Forget to place one on each side of the doorway...

Last but not least:
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Now that you have done all the hard work, it is simply a matter of creating a cube (512x512 and 16 Wide) and placing it directly in the middle of you doorway and "Subtracting" it to allow your segments a place to move to... Rebuild, and enjoy...

Rotating Objects

By: Knives

Dated: 12/8/98
For our example, we're just gonna make a simple rotating column in a small square room. Not very useful in the real world, but will be easy enough for you to follow to the letter.

1. Fire up UnrealEd, and carve out a 512 cube room. (if you don't know how to do this or anything else in this tutorial, you need to back to the basics. I recommend the basic room tutorials on unrealed.net.) Put your player start and one light in your room.
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Next, while you still have a 512 cube tool, carve out another room completely separate from your player area. 


3. [image: image75.jpg]


Next we'll make the brush you're going to use as your rotator.. We'll make an 8-sided cylinder, 16 high and 128 radius (128-16 inner). Don't add it yet! Move this into the center of your second room, making sure it's not touching any walls in any view. Add the brush to the world, and texture it the way you want it to look. 


4. Right-Click the CUBE button -> Properties again, this time making the brush a 360 unit cube. If you started from a clean slate, following my instructions completely, the red builder cube should completely surround the cylinder, and be completely inside your second room. Make sure you [image: image76.jpg]


look at the following screenshot. 


IMPORTANT NOTE: At this point you should not have used the scale, resize, or rotation tools. But many times you will have, so this is what you need to do before continuing:

a: click on the brush tool so it's all red -> right-click -> Reset -> Scaling

b: click on the brush tool so it's all red -> right-click -> Reset -> Rotation

If you have manually resized or rotated the red brush tool, YOU MUST RESET rotation and scaling of the red brush tool before continuing this tutorial! If you don't reset the size and rotation, the mover WILL NOT WORK!
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Click the button below the Subtract button, "Intersect." If you've followed my instructions correctly, the red builder tool will now be the same size and shape as the cylinder. Move the red builder tool into your player area and align it so it touches the floor, in the center of the room. Click the column 3, 6 from the top, "add mover" (white cube with swirls coming out of it.)


6. Now that we've created our mover, there's really only one remaining step, setting up the Mover Properties. Click in the Top View and hit B. This will hide the tool brush, revealing your mover as a blue cylinder. click on the edge of this brush, and it will become bright blue. Next, right-click -> Mover Properties. Change to the following properties:


+Brush:

CsgOper: CSG_Active

+Events:

Tag: ThisMover (can be anything, just make sure it's unique)

+Movement:

bFixedRotationDir: True

+Desired Rotation //as far as I can tell this is just -1, 0, 1

Pitch=0 //down/up

Yaw=1 //left/right

Roll=0 //banking left/right

Mass: 0.000000

Physics: PHYS_Rotating

+Rotation: (Pitch=0, Yaw=0, Roll=0) //this is positioning. you shouldn't need this.

+RotationRate: (Pitch=0, Yaw=5000, Roll=0) //turn speed.

+Mover: 

bDamageTriggered: True (I set this to true and set damage to 10000000; u may not need)

BumpType: BT_PlayerBump

DamageThreshold: 100000000.000000 (again you may not need.)

KeyNum: 0

MoverEncroachType: ME_IgnoreWhenEncroach //Optional action when player blocks

MoveTime: 0.000000

NumKeys: 0

Other Time: 0.000000

+Object:

InitialState: None //this is the important one! this makes the brush ignore the player.

Rebuild the map and give it a try! I think that should do it!

Mover Sounds

By: Millennium 2002
Dated: 30/9/98
Opening Sound:

This is the sound that your door will make when it starts "opening". I.e. I would place a nice creaking sound, so that the door will sound like the hinges need a little oil. Don't can use the "Looped" sound for this section, as it can cause your sounds not to work properly.

Opened Sound:

This sound is what the player will hear when the door has finished "Opening". If you have the door set to open wide until it hits the wall, then I would use a booming sound for it. This should NOT be a looped sound because it would keep playing until your door starts to swing shut.

Ambient Mover Sound:

This sound will be emitted from the mover while it is in motion. If you have a futuristic door, this might be a small hum from the motors whirling while it opens/closes. You should make sure that this sound is quiet and not overwhelming, as it will always heard in the vicinity of the mover whenever it is moving.

Closing Sound:

This sound is made when the door is closing. It will be heard when the door starts to close, and play over the top of any "Ambient Mover Sound" that may be selected.

Closed Sound:

This is the sound that is made when the door finally closes after being open. This is normally a good time to put in that really evil, booming thud that makes every bone shiver in a players body... :) I like to add in something as ominous as I can for that simply effect.

Ambient Sound:

You can select this from the "Sounds" menu, as compared to the "Mover Sounds" that the rest are kept in. This will allow you to have a sound playing in the vicinity of the mover ALL THE TIME. You should use this carefully, as it chews up system resources, and you may not want it to be playing after the mover has done something…

Water, Slime and Lava

By: Millenium 2002

Dated: 9/8/98 

Introduction:

Water adds a lot more depth to a level, whether it be in the form of a pool, a puddle here or there or perhaps a whole "Flooded In" level, with air pockets here and there... I assume that you have a level where you want to place water, so you should start off with a room already... 

Creating the water "hole":

Just as you would normally create a room, or a hallway or whatever for that matter, "cut" out the space for the water to go. I mean if you want a pool in a certain room, then make the room and cut out the place where you want the water to go into. If you are just starting out, it's a good idea to stick with simple things first, maybe a small square pool. 

Adding the water sheet:

Now that you have a place for the water to go, select the sheet* brush. When you see a thin red line, simply select the sheet properties (right click the sheet button) and select Floor ceiling orientation. The size of your brush should be a little larger then the hole you created for the water level (i.e. It should actually overlap the sides). Now place it just below the level of the sides - otherwise it looks like it's going to overflow) and hit the "intersect" button (the fourth one down on right hand column). This will then make the brush fit your water level EXACTLY. At this point you might say why not just make the same dimensions, right? Well that is because if later down the track, you want to add in things like rocks jutting out of the water, or you have water levels that are not rectangular, you will already know how to make the proper brushes for them - rather then having to learn a whole new method. Better to get it right the first time. You will have to load in the textures for water, so under the texture bar, select "load" and scroll along until you find "liquids", load it and choose a water texture for the sheet you want to build. Now that you have the sheet the right size, and in the right place and with the right texture, click "add special" (the fifth button down right hand column) and from the drop down list, select water. Simple isn't it??? At this point, sometimes - the water sheet won't show up - if this is the case, just "rebuild" the level, and it will be there. 

Creating the water itself:

Now that you have the water sheet, you can add the zone info for water... Where the texture bar is, select "classes" from the drop down list (it should currently display "textures". Choose info>zoneinfo>waterzone and right place it into the area your pool is in (right click in either a 2D or 3D view) and make SURE it is inside the area you want the water to occupy. 

Adding sound:

When you select the waterzone info and place it into the map, it will automatically add some sound into the water for you, but you can change the actual sounds that you hear by bringing up the waterzone properties (right click the waterzone icon - the cube with a question mark next to it). Then select "sound" and choose "ambientsound" this will then bring up some buttons. Click the 3 dots and you will be shown a list of sounds to choose from. If you haven't loaded any sounds, they won't be there yet, so to load them click the "load" button below the "sounds" bar and choose "AmbOutside". Then in the drop down list select "water" and play them until you find one that will suit your needs. Go back to the properties and under AmbientSound, choose "use". That's it, Done.

Rebuild and Play:

Simply rebuild your level, and play it to check out your water settings. To see more cool things that can be done with water, check out the following Advanced Water tutorial.

Advanced Water

By: Millenium 2002

Dated: 12/8/98 

Introduction:

Now that you have mastered what was in the first water tutorial, you probably want to add more cool water effects into the level, so here goes. 

Adding more then one exit from a water source:

This is actually quite simple, to have a water source with more then one exit, all you need to do is create the "hole" for the water to go into, and then place the required water "sheets" (I mean the water planes)and then add a water zone in between them. It is really not an advanced step, but most people NEVER tell anyone that it is so simple... 

Making the water surface "move":

Once again, this probably could go into a simpler tutorial, but I didn't put into the first water tutorial, so it goes here... If you don't want a surface texture from "liquids.utx" (they will bog down slower PC’s - or for whatever reason) but you don't want the plain simple water textures that are found through the rest of the textures, then select one (of the plain ones that is) and when you have placed it where you want it to go, select the surface (top and bottom) and bring up the advanced texture options. Click on "Small Wavy" or "Big Wavy" and it will move from side to side, and up and down. This adds a lot of realism, but won't chew nearly as much resources as an animated texture... 

Waterfalls:

Waterfalls are really cool. A waterfall does look best when it does fall into a pool, so when you have a pool - and a nice ledge, crevice, cranny (whatever) for the water to come from, create a solid cone or a rectangle (whatever shape will look best for your setting - but do it using the "sheet" tool) and select the add special brush as you would normally do, select the water plane (as you would normally do) and then place a "waterzone" in the middle of the shape. If you build it well enough, you may not even have to use two separate water zone, just use the one from the pool of water. Now select the sides of the water, and bring up their texture properties. Under the "scale" section, make sure that they are stretched going up and down, then go to the first tag and make them "pan" going down. If your waterfall is in a cave, you might also want to give it a fair amount of fog around the base, but if it's out in the open, then go easy as it may drain a lot of system resources. Waterfalls should not allow players to swim up them, so you will need to either make it a narrow size, or alter the gravity setting under advanced properties. A setting of a million (1000000) I think ( I hope I remember correctly) should do the trick, alternately set a gravity that pushes a player to the front or back of a waterfall. Lastly waterfalls need a waterfall sound, Furthermore, you should put a ambient sound in the "waterzone" AND around it. This will let the waterfall be heard from a distance and whilst a player is underwater. 

Protruding objects:

This is easy, but it requires a trick to perform. That is, the water plane MUST be added AFTER all the rocks (or whatever) are put into the water surface. I mean, if you have a pool and you want to place a rock or two jutting out above the water level, you have to place the rocks into the "water" before you actually place the water sheet into the pool. You will also HAVE to deintersect the brush before you add it into the map, otherwise, you WILL get horrible effects.

Animated Wave Textures

By: Millenium 2002

Dated: 24/11/98 

The Wave Engine

The wave engine in the editor is a great thing that does not seem to have been used in the actual Unreal Game. I have made quite a few water textures using this method, and I think (so do all the people that have seen them) that this type of water is much more realistic for outdoor areas, and has that "real water" feel to it. It will also make the impression that the water in the game is moving up and down and has little waves all over it. Well enough blabbering, time to get to the tute, eh?

Opening up the Wave Engine
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Ok, this is really easy. To open up Wave Engine, all you have to do is to go to the "textures" browser, Click on "NEW" and you will see a little dialog box appear. There are a few options here.

These options are basically what you will need to get you in. Here is a list of what each "setting" will do.

· Name: This will determine the name of the texture when you have the texture package (.utx file) open in the editor. 

· package: This will be the name of the texture package when it is inside the editor. Note that this is not the name of the actual file. 

· Group: This will be the name of the group that the particular texture belongs to. You know how you can open up the Unreal textures, and they are nicely divided into things like "Roof, Floor, Walls" etc? Well that's how it's done. Enter the name of the group that you want the texture to be in. If you want it to be in a group that already exists, just enter the name of the group (Case sensitive) and it will be there. 

· Class: This is the type of class that the texture will be. For this tutorial, make sure that you have "Wave Texture" selected, otherwise you will have serious problems trying to follow what is going on ;-) 

· Size: This is going to be the size of the texture that you make (in pixels). Most of the time, you will want a larger texture, although you could of course use a small one (say 64x64) if it's going to be repetitive, or placed on a small item. I would however suggest that textures to be made for general purpose (and certainly for this tutorial) are at least 256x256 large ;-> 

· Create this Texture: Well, this is the wonderful button that you will want to press when you have entered in all the stuff that you have to enter in. Simply really :) 

· Cancel: If you don't know what this will do, then I ain't gonna tell ya. Hehee 
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Ok, now that we got that out of the way, we can actually start to do some cool editing here. 
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This is what your screen should look like now. Ok, you got that? Now there are a few things that I will explain first. Here is a lit of what you will be playing with. Click on any of the entries to change their values. This image will explain what I am talking about here.

· Bump Map Angle: This setting will determine what angle the Map will be "bumped" from. Not all that important really from what I have found. It seems to go very weird if you set it to high levels (above 230) and also makes your phongs disappear if it is set to a very low level. 

· Bump Map Light: This setting will determine just how much light there is on the Texture. It has got nothing to do with where lights will be placed in the actual game, just while you are making the texture. The more light there is, the lighter the water will be, and the less Phongs you will see (Phongs are explained later). I would suggest that you keep the Light at either the level that it starts off at, or add in a little more. Dark waters tend to look too black to be realistic, but everyone to their own eh? This setting bar will be brightest at 128. The scale will work in such a way that 0 is pretty much black water with little "phongs" of light (Yes, I will explain them in a sec) appear on the tops of the water, 128 is the brightest level possible with the water being almost white and the waves showing up nicely, and 255 will set the water to show waves once again, but there will be no Phongs Visible at all. 

· Drop Type: This will choose the type of "brush" you will be using to "paint" the waves onto the water. This is a drop menu, and there are heaps of options in it. I will list them all and what they do further down. Right now, all you need to know is that it chooses the type of drop/plop/gloop that you will be adding to the water.

· FX Amplitude: Sadly, this feature does not seem to do anything right now. Perhaps it is a setting that will be implemented in the retail version of the editor. 

· FX Depth: I cannot find a real use for this entry, as it does not seem to change anything. I might be wrong, and if you find out what it doesn't, then please tell me so that I might be able to explain it here, but until then, it gets a "Not Here" rating. 

· FX Frequency: This setting will change the speed at which the waves are produced from the actual wave brush. I.e., if you make an Oscillating Horizontal bar, and set it to 8 (The default) then you will get say, three waves every second. Set it to 32 and you will get 12 waves a second. This will not make the waves any larger, or higher, or make them cover a larger area, just will make more of the appear each second. 

· FX Phase: Well, here is another "I don't know if it does anything" setting. It does not seem to make any real changes when you are playing with it, but Once again, if someone finds what it does (or knows) then please drop me a line, and I will correct myself here :) 

· FX Radius: Well, I would have thought that this setting would alter the radius that "random" water brushes (like rain drops) take the value of. I.e. a larger number would make the rain fall into a larger area, but this does not seem to be the case. It doesn't seem to do much at all. Perhaps I am using the wrong brush here, but I have tried it with most of them, and it has done nothing. Oh well, I guess we are using a BETA editor eh? 

· FX Size: This one, I can tell you what it does :) When you change the setting here, it will change the size of the brush that you are using to "pain" the waves with. For example, if you choose a small setting (like 4) and use a vertical oscillating brush, then you will make a waves that looks almost like a drop of water, but if you change the setting to say 32, then it will make a brush that is almost a quarter of the texture. This setting comes in handy when you want to make a wave texture that is not "repetitive" and so that you can make it look more natural and make the waves vary in size and shape. 

· FX Speed: Ok, this one has got me beat. Sorry, No real idea what (if anything) it changes. 

· FX Time: Unfortunately this feature does not seem to be implemented here. I have once again tried it with a few different brushes, and it seems to make no difference to anything. Perhaps someone out there knows what it does, and want to mail me to tell me? 

· Phong Range: Well, I said that I would tell you what this means so here it comes. A Phong is the little bit of light that is reflected off a wave as it passes along near a light, or with a light behind it somewhere. When you have looked at the ocean or a lake, you will see that the water is full of little "glints" of light, and there is always a little bit of a sparkle somewhere. Well, this is called a Phong. The Phong Range setting basically determines how far away from the center of the brush, this particular phong can travel. If you play with just one oscillating brush, you will see what it really does. I would suggest that you set it to something small (like 4) and make a wave. You will see it right near the actual center of the brush but it will not travel all the way with the wave. If you set it to a higher number (like 128) then you will see that it should travel along with the wave to almost (if not all the way) to the end of the actual wave. Phongs will also be created when you have waves meet each other to form new waves. 

· Phong Size: This will determine just how large a phong is on a wave that is made. You can make the phong very small (like 4 or 8) and you will only see a small glimmer on the crest of the wave, or you can set it to a high number (255?) and you will be able to see that almost half the actual wave is covered in a bright light (i.e. the phong). I would suggest making it a fairly small number so that the glints look realistic, and not like they are all over the place, and I would also plan ahead and choose just how much light will be falling on that particular texture. If it is a small amount of light, then I would only use a few phongs here and there, but if you want to place the water right in the middle of a brightly lit up courtyard, then have a fair few of these things floating about, and it will enhance the effect of the lights, especially if you have water somewhere else that is a lot more "dull" so to speak. 

· Wave Amplitude: Well this one is easy :) This setting will determine just how large your waves are. The higher the number, the deeper and higher your waves will be. A low setting would be great to use if you want to make a water texture look as if it is almost calm, and a high setting would be good to use near a water fall. Play and see with this one, as it depends completely on what type of water you are trying to make. 

Ok, that pretty much covers all of the settings. here is a list of what each of the different drop types do. There are a lot of brush types to use, although most of them are actually just alterations of each other.

· Drop Fixed Depth - This will make a little "dint" in the water that does not go up or down, but just stays at the level that you set it to. I find this one quite useless. 

· Drop Phase Spot - This will make a little drop in the water, that I just like having a drop of water falling into one part of the texture all the time. It will also keep a nice little circular wave being formed around the drop center. 

· Drop Shallow Spot - This will be just like the "Drop Phase Spot" although it is much smaller. 

· Drop Half Ampl - This is once again similar to the "Drop Phase Spot" but it uses exactly half the Amplitude that you have set (Explained later). The size is very close to the "Drop Phase Spot" 

· Drop Random Mover - This will make a little pattern of waves dance all over your image. It follows no pattern, and actually looks quite like a little water bug running about on the surface of the water. Very cool and useful. 

· Drop Fixed Random Spot - With that name, you might expect it to move about the texture, but it actually stay almost in the one place, only moving a little bit to the sides, so that it will make the waves collide with each other, thus making them look much more realistic, then if it were just in the exact same place each time. 

· Drop Whirly Thing - Damn, I think that name is soooo creative...) Anyway, this setting will create a little "drop" of water that moves about in a small circle (not a regular one though :) and looks very much like a little bug once again that travels about on the water. 

· Drop Big Whirly - Same as above, but bigger and makes bigger waves. 

· Drop Horizontal Line - Make a line that will go down into the texture. If you place just one of these, it will most likely look like it disappears soon, but if you place a LOT of them all over the texture, then you will see that it makes the texture look like it is all moving. 

· Drop Vertical, Diagonal 1 & 2 Line - Same as above, but the wave is in a different direction. 

· Drop Horizontal Osc - This will make a line wave (Like the above) but will actually keep the wave moving up and down all the time, so that it will make great looking waves on your texture. Very useful if you place even just a few on the surface, and let their waves meet and collide. 

· Drop Vertical Osc, Diagonal 1 & 2 Osc - Same as above, but in a different direction. 

· Drop Rain Drops - This will make a random drop fall in the general area of where you click the mouse. Very nice and useful. 

· Drop Area Clamp - This will "raise" a part of the texture and make it look like there was a pipe under it pushing water up into the surface of the water. I have found very little use for this one. 

· Drop Leaky Tap - This will make a drop fall into a set place (where you click) and it will keep dropping there in a steady and "leaky tap" like manner. 

· Drop Drippy Tap - Damn, who makes up the names eh??? Anyway, this is just like the one above, although the drops seem to come about twice as fast. Very useful. 

Right, that is out of the way. Now to actually paint with the stuff, all you have to do is to choose a wave brush (one of the things in the list above here) and click on the blue texture box. This is the box that has opened itself along with the properties bar. Nothing that hard there really is there? Heh. Enjoy and make good water.

Sky Boxes

By: Millennium 2002

Dated: 9/8/98 

Introduction:

I have been asked quite a few times about skyboxes, so this tutorial should hopefully explain just what is the go with em ;)

The Theory

A skybox is simply another place in the level that will show up as the "outside" edge of your level. You will often see a nice level that is based in the underground, and with a few places that show light (or the sky) and yet they all look identical, and seem to actually be made of the same sky. This is because the thing that the player is seeing IS the same piece of sky. A lot of people who start making a level, and try to have a nice sky will try to create a Sky for each part of the level, but this is certainly the wrong thing to do here. Wouldn't it be so much easier if we were able to create a little "room" with a sky in it, and then simply click on a property of a texture, and say "Don't show this texture here, but show what is inside the little room with the sky in it". ? Well that is basically just what we can do.

The Sky Itself

To make the sky itself is probably the hardest part. Sure, it's easy to make one that will do the trick, but it's a lot harder to make a really good looking sky that is worthy of a real level.

There are a few guidelines that you should stick to when you are making a good skybox.

· Size

The size of the actual skybox is the most common mistake that is made by people when they first start. Most people assume that the skybox will have to be large enough to cover the entire "sky" of the level itself. This is not the case at all. It is a norm to make the skybox about 1024x1024x768 or that is the size that should work well with most levels. This is large enough not to get too tricky, but at the same time, it's also not too large to start getting messy with lights and the like, and will not hog too much system resources when the level is being played. 

· Shape

Did anyone ever say that the shape of a skybox HAD to be an actually "box"? No! I do often use a box for simplicity, but if you have a level that will only be showing one side of a skybox, what is to say that you can't make it in a wedge shape, or perhaps a nice spherical shape? There are limitless possibilities that you can use here but I just wanted to point that out, as it seems to be a "assumption" that most people make - wrongly. 

· Lighting

Lights are of course very important to use in a skybox, and there are a number of things that you will want to consider before you start throwing them in. 

· Dynamic Lighting: While there is nothing to say that you can't use dynamic lights in the skybox, and they certainly look really nice, you will find that they are actually rarely used in the main Unreal levels, as they do hog resources like little else. Think about just how much resources Dynamic Lights can use when they are in a level itself. If you use one that is slightly larger you will notice that it will really slow down a smaller machine, and the same goes for their use in a Skybox, although it is actually multiplied somewhat. When you place on in a skybox, it greatly increases the amount of resources that will have to be assigned to it, and can really slow down a smaller unit when the person is playing. This is one of those tricky things however, because if the level generally plays VERY well, and the skybox will only bee seen from a place that has little "happening" around it, then sure, throw something nice in and give the players a little more eyecandy, but if you have a huge open (or outdoor) level where the skybox is seen from a lot of places and there will be fighting etc, then you might want to hold off the eye candy and simply go for better playability. 

· Fog: Please don't use fog in your skybox. It won't work. It will however still slow down your level quite a bit. The reason that you level will slow down but the fog won't be seen is simply because to see fog in a level it the player HAS to be in the same Zone as the fog. Now if you place fog into the skybox, you will still have the fog there, and if by cheating the player actually "flew" into the skybox, then technically yes, it could be seen there, but if the player is normally playing the level, they would of course not be in the same zone as the fog, so it would not be seen at all. However because the fog "technically is there", the PC still has to do all the horrible calculations for it, in the case that the player was to fly into the area. Once again, I am simply going to say Don't! 

· Colored Lighting: Colors will normally add in quite a bit to make your sky look a lot nicer, and it will also not hog too many system resources. Most good skyboxes (You know the ones that you stare at for ages, until some monster creeps up and shoots you, at which point you have to "snap out of it" and start playing again) will use quite a few colors, and you might even think that they are somewhat "psychedelic" if you look at them for too long, and try to "work them out", but if you simply look at them, then you will think "Yikes, what a lovely sky there is here...". That is the effect that we are trying to get here. Feel free to use lots of nice colors in your sky, and if you want to have a level that looks realistic rather then painting it with splashes of many colors, why not create a sunset, or sunrise and have the sky painted with a myriad of yellows, oranges and reds. 

· Movers

You can place movers into your skybox, but once again, it can be a little straining on resources and keep in mind that whatever you put there, will most likely be MUCH larger when you see it in the actual game. However a good use of a mover in the skybox, is a VERY good way to add in that little "extra" to make your level stick out above the normal that most people are putting out. For example, if you have a good level that is set in a futuristic timeframe, why not create a space ship, or fighter plane (whatever) that is triggered by something in the level, and it flies across the sky, then disappears not to be seen again. If you have played Quake 2 (I guess that most people have done so) you will most likely remember the first level, when there is all sorts of broadcasts going on, and you can see and hear the fighters as they fly over the base, then are not seen again. This may seem like a LOT of work for one simple thing that will never be seen again, but the "shiver" that most player will get, will be worth the work you put into it. 

The way to make a skybox.

I have left this to last, as I really wanted you to read all of the stuff that I have written about them first, and to keep it in mind as you are creating your own sky box, as all of the stuff there has been learnt from many hours both playing and editing levels, and it would seem like an awful waste for you to read this bit first, then miss out on all of the "little tricks" that I have written there. 

Ok enough crap here on my part. You have waited (and read) enough. Here is the go...

A skybox is a simple thing to create. All you need is a "room" (which as I said, can be a box, and sphere, whatever) as long as it does not have any holes in it. When you have made you sky to look like whatever you want, click on the class browser and then open the ZoneInfo menu (click on the little + sign next to it). Choose Skybox info and then place that into the skybox, by right clicking in the 3D view and selecting it from the drop menu.

When the zoneinfo is in the skybox itself, all you have to do, is to open the "advanced properties" of a texture, and then highlight the "fake backdrop" option. This will not appear to do much at all. It will only work in the actual game, or when you test it out from within the editor. If you have any further questions about the tutorial, then please contact me (millennium@planetunreal.com?subject=Skybox_Tutorial) and I will see what I can do to help you further.

Colored Lights

By: Verxion

Dated: 16/6/98 

Introduction

This tutorial will go over colored lighting, and how it is done within Unreal. Colored lighting is really quite simple to do. Just remember, don't go nuts with colored lighting or you can overwhelm people.

Colored Lights

The first thing you need to do is make a test room. Make this one fairly large so you can have lots of different lighting in it. I leave it to the student to know what "fairly large" means.)

Well, I have been thinking of the best way to show you guys how to make colored light. Since all I am really covering is how to make a light have color, this assumes you already know how to create a light in the first place. What I will do is show you how to make a room with some cool colored light, that has some cool lighting effects that are darned simple to do. 

Since you made a room, you must know how to size your brush. Well, size your brush so that it is fairly small. How small? Well, how about 25x25x25 or so. Hopefully you can fit several of these into your room. Arrange three of these cubes on the floor as shown below: 
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Here, you can see 3 cubes on the floor, waiting for colored light to "happen".
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These are the same 3 cubes on the overhead (xy) view.

See the note at the bottom of this tutorial now. It is very, very important to help you understand the rest of the tutorial, but it is kind of off of the real topic at hand. If you already know what Hue and Saturation are, you probably will only want to glance at the important note after going through this tutorial. 

***Go read the important note, then come back to this part of the tutorial*** 

Now, place a light in between the three cubes, at a height halfway up the cubes. Right click on the light, and choose "properties". Now, under the properties, choose "LightColor". 
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This shows the LightColor section of Light Properties.

Now, hopefully, you know what Hue and Saturation you want. Place the values you want in those two spots. If you don't see the color you expect, lower your saturation value, and it will VERY likely fix your problem. If you don't have a specific color in mind, we can choose values of 200 for brightness, 30 for the hue, and 64 for the saturation. Now, make certain that this one light is the ONLY light on your level, and do an F8, rebuild, then ctrl-p and take a look at it. 

Now, change the value of the hue to each of the following values: 230, 163, and 100. You can see quite clearly that the Hue value walks you around the color wheel. 

Well, you are now off on the great road of color! Use the force wisely, for it can corrupt the soul, er, um, nevermind.

Good Luck! 

IMPORTANT NOTE!!!: 

Ok, at this point, we are going to make a diversion from an otherwise perfectly normal tutorial. :-) One of the reasons colored lighting can be so difficult for people is that 99% of it is done "blind". You just type in numbers and try the level. This is VERY tedious. It turns out that inside of UnrealED there is a place that has the colors, and they are labeled. But this area isn't available while you are editing light colors. A poor design decision. What I am going to do here is show you how to get to this color area. Once I have done that, we will resume the tutorial. If you don't already have a "zoneinfo" on your level, make one (it is in classes -> Actor -> Info -> ZoneInfo). Inside of ZoneInfo, choose "ZoneLight", and click on the black color bar next to "FogColor". Now, to the right of the black color bar, you will see three dots in a button. Click on this button. 
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This is the ZoneInfo Properties area that leads to the color chart.
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This is the color chart itself.

Ok, now you should see all kinds of colors. To my current knowledge, this is the ONLY place that allows you to see colors in a chart like this in UnrealED. Important things to note when looking at this chart is the block of color, the slider to its' right, and the text entry boxes under the color block. The important text entry boxes are "Hue", "Sat", and "Lum". 

You can click in various different spots in the color block, and the values in the entry areas will change to reflect the color you have chosen. To the right of the color block, is a small slider that lets you adjust the "brightness" of the color, and this value is reflected in the entry marked "Lum". The color you are creating by using these tools is shown in the "Color | Solid" area. 

PLEASE understand that this color chart is intended to be used to adjust that fog color I showed you earlier. This tutorial is about colored lighting, and we won't be dealing with fog right now. Therefore, I am just showing you this area since it will allow you to visually see what "Hue" and "Sat" you want for your colors.

Reflectivity

By: Millennium 2002

Dated: 9/8/98 

Introduction:

The first thing to decide is where you will have reflective surfaces. I mean, you CAN have them everywhere, but there are a few guidelines to placing mirrors and reflective surfaces. These are simply here to make your level playable on something that does not resemble NASA and so that you will actually be able to see (I will explain this later) 

Where to put Reflective Surfaces:

1. Mirrors are generally best placed on walls, as this means that anyone passing them !Should! see themselves. 

2. Partly Reflective surfaces (not mirrors, but say a marble floor with a high polish) seem to look best when they are used as a floor, as this gives a beautiful effect of reflectiveness - but not a mirror (have you ever seen a mirror on the ground?) 

3. When placing mirrors, make sure you don't place them ALL around a single area with lights in it, as they will all reflect the light, thus amplifying the light to a ridiculous level and generally SLOWING that section of the map to a ridiculous speed (completely unplayable on everything but NASA). 

4. Mirrors and reflective surfaces unfortunately WILL slow your level down, so I would suggest that you use them sparingly - mainly for eyecandy - rather then using this as a main playing feature. :) 

Full Mirrors:

To create a full mirror on a surface, select the surface and go into Surface properties (Right Clicking). Now check the boxes "Mirror" and "Unlit".

1. "Mirror" will turn the texture into a mirror (Duh!) but this will also cause it to be unaffected by the lights around it, which means that it will be a black surface until something like a Blaster (the first gun, just in case...) is set off next to it. Then and ONLY then will it actually show up as a mirror to the light generated from the blast :( 

2. "Unlit" will make normal lighting effect the surface. I mean, if you have a nicely lit room, the mirror will look like a normal mirror... :) 

Partly Reflective Surfaces:

Now we are talking floors, polished surfaces and dirty mirrors (the cool stuff that is...). Simply follow the same steps as above, but this time ALSO check the "Translucent" box under the Surface Properties. This will make the surface act like a mirror, but also allow you to see the texture that the surface is drawn with. This works VERY well for floor using the "marble" textures. 

Additional Notes on mirrors:

Mirrors will not show up until you are in the actual game - I mean they will not show up as mirrors when looking through the 3D view of the editor... Don't worry this is perfectly normal and is there to make your editing life easier. As I said before, mirrors and partly reflective surfaces are best used sparingly, as they DO! Slow down the gameplay.

Fire

By: BEG

Dated: 1/6/98 

1. After you have UnrealED loaded, you can load up the texture sets that you will need, over in the Browser pane you should see a group of buttons at the bottom of the screen, press Load and load up the Ancient and GreatFire packs.


2. Now we want to make a simple room, right click on the cube brush and select "Cube Properties..." this will pop up a box where you enter the width, height etc. Change the Height, Width, and Breadth values to 512, hit build this will resize the cube to the new values, then hit close.


3. Go to your Browser pane and select Ancient from the dropdown menu and select a wall texture you want to use, hit subtract and we now have our room. You can now change the floor and ceiling textures if you want.


4. Right click on the Cylinder brush and go to "Cylinder Properties..." Change the height to something like 128 and both Inner/Outer Radius to 64, hit build and close the popup window.


5. Move the Cylinder until it's in the center of your level and is flat on the floor, select a new texture for the Cylinder if you want and Add it to the world.


6. Right click on the Sheet button on your toolbar menu and select "Sheet Properties..." This is what the fire will be placed on. Set the properties to Y-wall, U value of 64 and V to 128. Build the sheet and close the popup window.


7. Move your sheet so it is in the center and sitting on top of your cylinder that you added into the world. Select a fire effect to apply onto the sheet, such as 'ANCPURP'.


8. Click on Add Special brush in your toolbar, this will popup a new window, on the drop down menu select masked texture, then change the visibility options to 2-sided, and make sure Transparent is checked in Effects. Click add special and then close. The fire texture may be tiled but don't worry about it at this point.


9. Click on the rotate button on the toolbar and rotate your red sheet builder so it is at a 90 degree angle from the one you just created, and repeat step 8.


10. Now your fire texture is probably tiled so highlight them in your perspective window and enter their surface properties, under scale make Simple Scaling 2 and hit apply, the textures should be sized correctly now. 


11. Place lights, now place a light or multiple lights and tweak them until you are satisfied with the lighting.

Note:
Don't place lights directly above your fire effect they will drown out the texture and will make the fire like ugly.

Add a PlayerStart and rebuild your level.

Lens Flares

By: Millennium 2002

Dated: 22/10/98 

Introduction:

When you have placed your lights in the level, you will need to open up a new texture package for the lens flares them selves. To do this make sure you are browsing the "textures" in the right hand bar, and click on "Load". When the dialog box appears, open the GenFX.utx package, and you should see all the possible textures that are there. 

Selecting the Flare:

When you find the light that you want to have a flare on, bring up it's "advanced properties" by right clicking on it, and then go to the Textures bar. Choose a texture that will suit your room, and click on it. Then go back to the Light Properties, Choose DISPLAY>SKIN and you should see a little Input there. Press the "use" button and your new texture's name should appear in the box.

When that is done, go to LIGHTING>BCORONA and set it to "true" (default is "False")

Adjusting the Size of the Corona:

You can at this point rebuild your level (AutoBSP and Lighting) but your flare would probably be way too big to look good. Let's fix it to be the right size, eh?

Select the Light Properties again, and choose DISPLAY>DRAWSCALE. The default here is 1.00000 but you will probably want to have your one set between 0.3000 and 0.5000 (Hell, I'm guessing how big you want it here.)

Lastly:

There is just one more thing I think I have omitted so far... In the Light Properties, you have to change a few settings. Select LIGHTING>BCORONA and set it to true, otherwise your Flare won't be visible, and there is another setting there called bLensFlare, but that one doesn't seem to do all that much, so you might just leave it set to "False".

Zone Barriers

By: Millenium 2002

Dated: 16/9/98 

Introduction:

Zones can be quite tricky if you don't really understand how they work, so if we explain them and how they work, life should be a WHOLE lot easier. 

Setting the scene:

Zones are used by the editor to know when to stop filling an area with water, they also tell the editor when to make changes to the ambient lighting in an area. They can be used to accomplish a million things, but to do so we must understand how they work. A zone is simply an "invisible wall" that does not affect the player, i.e. doesn't stop them or anything like that, but tell the editor to stop doing whatever the last zoneinfo told them to do. A zone is automatically placed for example when you use the "Add Special > Waterzone" button. This not only adds in a sheet that can be textured, and made to look nice, and the rest of it, but places an invisible zone barrier, so when we place the "Waterzone Info" below the water line, the editor puts the water UNDER the sheet, then stops adding water to the rest of the room. You can set these barriers in pretty much any way you like, so if you want a complex waterfall, you can make it look really good by using a complex brush, then selecting "waterzone" and adding it in. A zone does not have to be a sheet! It can be any shape that can be made with the construction brush, although sticking to something that isn't too complex is normally a good idea... 

How to use zone barriers best:

Technically you could set up a barrier wherever you like, but it is a good idea to be able to place them (assuming they are not a water zone etc) in a place where you will not readily be able to see both zones at the same time. I mean a good place for a barrier would be in a hallway, placed so that the player can see into either zone, but not both. This then stops any problems about Fog not being seen from afar or other problems that can occur. On this note, if you have fog that you would like to add in somewhere, then make sure that you set the barriers in a place where you will not be able to see the fog from. I mean, place the barriers around a corner for example, as when you set a zone to have fog in it, if you should be able to see the fog from afar, and the player is inside another zone, then they will see the light, but the fog will not be seen from the other zone EVEN if it should be in plain view - so keeping barriers around corners is a good rule of thumb to stick to... 

The best way to create the barriers:

A barrier MUST completely fill the gap where you want it to be. This may sound silly, but most problems occur when a map editor places a barrier and it looks OK, but the editor keeps finding a TINY (It may not even seem to be there at all...) hole and assumes that it is not a barrier at all, so when you place a barrier, make sure that you create a sheet (or other shape) that is bigger then the area you want the barrier to be in, and INTERSECT it with the world. This means that the editor makes sure there are NO holes in it. This also is generally a better way, because it will make a smaller brush thus putting less load on the processor. 

Prefab zones:

The editor comes with a LOT of pre-programmed zones, and for the most part, these will do quite nicely. There are "Water Zones", "Lava Zones" and a whole lot more. These should be allow you to create a fair amount. If you want to create a Fog Zone, then have a quick look at the "Fog" tutorial on this site, and it will tell you what you need to know. If you want to create your own settings for zones then I should have a tutorial posted on it shortly.

Fog and Clouds

By: Millennium 2002

Dated: 9/8/98 

Introduction:

Fog adds a feeling of being there, and that's what we want from our levels isn’t it? 

Setting the scene:
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Before we get into fog, we must allow our editor to draw the fog. When you have selected a room for the fog to go, and go into the texture bar, but select "classes" now go into Classes>Info>Zoneinfo . Now add a "ZoneInfo" into your level. It doesn't matter where you place it, as long as it is in the same zone (don't place it underwater, if you want the fog just above the water level for example) as where you want the fog to go. Now open up the advanced properties, and then the ZoneInfo tab. Change the "bFogZone" to TRUE, and close the advanced properties.

The light settings:

Well the hard part is out of the way, so now it's a simple matter of placing the lights where you want them, and editing their settings like this:

[image: image82.jpg]


The "Volume Brightness" setting will determine how bright the light is inside the volume of it's area. The "Volume Fog" setting will determine how "thick" the fog is. The "Volume Radius" setting will determine how large the area is that the light and fog effect. It is possible to play with color settings as well, to create colored fog. In the example show here, I have created purple fog (No, not a "Purple Haze").

A Little Warning:

Fog !!SLOWS!! down PC’s, and it should really be used sparingly. Creating a Huge outdoor setting, then filling it with fog might sound cool, but unfortunately, it would be unplayable on everything but NASA! 

If you have multiple zones, you will find that fog cannot be seen from one zone to another, so if you want multiple zones, then make sure you place a "ZoneInfo" in each zone where you want the fog, and set it to the above configuration. 

Slippery Surfaces

By: Millennium 2002

Dated: 28/11/98 

This is something that is quite cool in a level, and most people want to have some part of their level slippery. It might be as simple as having a polished floor that is supposed to be slippery, or perhaps a wet bridge or whatever. Well to do it, really is quite easy, but DAMN hard to find, if you have not done it before. Here is the way to do it.

I assume that you have already got your level made here, and simply want to add in a little area that is slippery.
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Ok, what we are going to be playing here with is actually a zone. We will need to create a zone that will completely cover the area that you want to have slippery. This in my case will be made with a box (as the room happens to be roughly a box). Here is a pic of the inside of the room. I have made a cube brush to the same specs as the room, then intersected it just to make sure that it's exactly the right size.
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Now we have to create this into a zone. That's easy as well. All you have to do is the following:
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That will create the brush that you have just made into a zone portal that is not visible and does not stop the player walking through it in any way. Basically it's something that only the editor's will see if they open the map. When you have created your new brush (you should see it as a green brush in the level) you will have to place a zone-info into it. This is where we will actually set the level of slipperiness in it. Open the "Classes" Browser window (where the textures normally are) and select Info-->ZoneInfo You will most likely fin that as soon as you open the ZoneInfo bit, you will automatically select "Waterzone" but highlight "ZoneInfo" again, and then place it inside your room. (I find this the easiest in the 3D view). Now you should see the lovely little ZoneInfo in your room.

Open the advanced properties of the zoneinfo, and select ZoneInfo-->ZoneGroundFriction. This will automatically be set to 4.000000. This is what we want to change. This particular setting will change the friction that the player has between the floor and the mesh. Keep in mind here that it's a ZONE setting. That means that if you want only a bridge set to be slippery, you should only make the brush (the one that will end up being your zone) only as big as you want the area to be slippery. If you want a whole area to be slick, then sure make a nice big zonearea, but otherwise be careful what you include as most people will not want everything slippery. The other thing to note, is that everything will be made slippery. I mean, if you have a an area of sand there, it will also be effected, and that would be kinda weird. I mean I don't care where you are - Sand is NOT slippery. Feel free to tell me where you will find sand that makes you fall, but I doubt it. Sorry, too much blabbering there. Let me go on.
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I want this room to be quite slippery, so I have set the friction level to 1.00000. This should be more then enough to make a player go "Yikes! WTF?!?". Then it's a simple matter of rebuilding the level, and playtesting it. I have included a final image of the settings that I have used here, just in case there is a problem in what I have said here, but I think it's actually quite simple to do.

Well, that should be it. You should now have a lovely slippery area in your map, that will make the best of players slip up, and be extra careful =)

Final Notes:

When you add in the zone portal (The special brush) You will see that it seems to actually be visible in the level. That is completely normal. When you rebuild the lighting, you will see that it is not affected, and does not show up as visible anywhere apart from the editor. This is still there as a texture so that you can actually see it in the 3D window, and to make your editing life easier.

"Quake 2 style" Teleporters

By: Millennium2002

Dated: 27/6/98 

Introduction
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I was recently asked how to create the famous "Quake 2" style Teleporters.

Fair enough. It's easy - here is how you can do it. I will not go into detail here on how to create the shapes of teleporters, or how to create the texture that I have used here, but only deal with the Real Fun stuff. If you really want to know, I used a simply cone for the basic shape, the floor lofter for the base, and the "fire Engine" for the texture. there, that's about as detailed as that's going to get. The good stuff follows.

You will need a really basic understanding of the editor here, as it's so damned simple! First make two rooms. Do not connect them in any way. Make sure that they are separated from each other completely. I have made these rooms 256x512x768 but it’s completely up to you. I have made the two room to look completely different, but once again, that's up to you. It might be a good idea to try to make a teleporter series that sends the player to places that seem identical just to be really confusing, but that's another story...

The teleporter

Locate the place in the 3D view where you want the first teleporter to go, and open the "Classes" menu. Open the "Navpoint" subclass, then choose "Teleporter" (Coincidence? I think not...). Now you most likely be automatically moved to the "favorite" thing, but select the normal teleporter again, and place it in the 3D view where you want it to go. This will be the first teleporter that your player sees. Well, actually if you are placing these into your level (and not making a little tutorial level then it makes no difference, otherwise it will be the first one that the player sees). Ok, That done, open the advanced properties of the teleporter (right click on the icon) and select the "Event" tag. name it "One" [image: image88.jpg]Hle Efit Script
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under Tag. This will name the teleporter for other teleporters to link to.
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Ok, that was easy wasn't it? Now go to the place where you will have your second teleporter and place it in, just like you did the first. This will be where the first teleporter sends the player when they walk through it. Now, in the "Event>Tag" entry, type in "Two". Sheit, I am so damned creative with names for teleporters eh? Hehee. This time, when you have entered the tag (the name of the teleporter) also open the "Teleporter" menu from the bottom. Right at the bottom there is a entry names URL. This has got nothing to do with the net, but actually refers to the teleporter that the player will be sent to from this one. In the field type in "One".

Now, go back to your first teleporter and in the same field (the URL entry under Teleporter) and enter "Two" as the URL. This will create a simple loop between the two. When the player walks into one, they will be sent to the other. This is the most basic of teleporters. I.e., one send to the other, and vise-versa. It will let you make nice teleporters. The following will explain some of the more complicated things (although still quite easy) that you can do with teleporters.

Pathed Teleporters:

I don't know what to call them, so I made up that name, but this will simply make a chain of teleporters, rather then just having the two that send the player back and forth. To make a "line" of teleporters, all you will have to do, is to create a third (or fourth or fifth etc) teleporter, and change the URL corresponding to the teleporter that you want it to go to. This will then send the player to a different location if they try to "weasel out" and go back to where they came from. Nice if you have a particularly nasty monster near a teleporter, and the player tries to flee back to where they just came from. Nice to send them to a dark place that has yet another monster there. ( I think that I am too nasty sometimes.... Oh Well. Sue me.)

Single Destination Teleporters:

You can make a whole heap of teleporters all have the same destination. All you have to do is to change their respective URL's to the same tag of a teleporter. This is a good idea to do, if you want a series of "one way" teleporters. This will allow you to have a teleporter go to another, and then send the player to a destination if they try to run back through the teleporter that they just came through. A nice deadly trap comes to mind...

One Way Teleporters:

This is really simple. All you have to do, is to make the teleporter's URL entry blank. This way a player will not be able to run away from whatever you have in the new part of your level.

See I told you it was really easy. That's all that I can think of to place into the tutorial right now, but if you have further questions then email me.

Portals 

By: Isolation

Dated: 27/6/98 

Intro

This tutorial is to make portals. If you are new to UnrealED please read and understand other tutorials because making portals isn’t the easiest in the world. 
Skill: Medium – Advanced (Have to know the interface, and what you are doing)

Time: 20 Minutes

The Basics
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Lets begin with a simple room, I am going to use the exact coordinates I used for my Portal map for this tutorial. The room was a 400 unit height, and 600x600 on Width and Breadth. Create the room, texture it, and throw in a PlayerStart. Now we will add two boxes. This is the space where the Portals will be. Thanks to Inoxx from the Unreal team the portal boxes HAVE to be 64x64x64 or bigger. For this little map we are making make it 200x300x200 (height*width*breadth). Put it on the outside of the room but make sure the end of it is touching the room then hit on the subtract from world button. Now let’s change the brush marker to 200x200x300 this will show the same cube but now to the side. Put it on another wall and extract the world (just like the figure). One thing to remember both of the portals have to have the EXACT same geometry as the other. One CANNOT be bigger than the other. Please make sure both of your portals are done correctly.

The Portals

Now we will create a sheet to do this click on the button all the way on the bottom of the toolbar that looks like a gray diamond. This will change the marker to a thin sheet, now right click on the sheet button and go to Sheet Properties make the Orientation Y-Wall to make it vertical and then the U value should be 300 and the V value should be 200, hit build. Place this sheet in front of the portal that it fits and then click on the Add Brush button. Now go to the Sheet properties and change the values from 300x200 to 200x300 and then the sheet will change direction to the other portal. Put that on the cover of the portal like the figure and hit Add Brush*. If you did it correctly it should look like the next figure.
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*- If you don’t see anything please Rebuild geometry and if you still don’t see anything make sure you added the brush.

The WarpZone
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Now we will link the portals together. Go to the Classes menu -> Info -> ZoneInfo -> WarpZoneInfo. Add a WarpZoneInfo inside each of the boxes make sure they are in correctly at the X and Y values. Now Go to the WarpZoneInfo properties by right clicking on the WarpZoneInfo tag (it looks like a cube with a question mark) and go to WarpZoneInfo. You will see two boxes OthersideUrl and ThisTag. Double click on Othersideurl and enter the value warp1 and then double click on ThisTag and put in the value warp2. Now go to the other WarZoneInfo in the other portal and go to its properties. Do the same thing as you did with the first one but this time the Othersideurl will be Warp2 and ThisTag will be Warp1. Close the box and you are two steps away from having portals.

Surface Properties
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Now click on one of the sheets we put in before, right click it after its been selected and go to its properties. Check Portals, 2 Sided, and Invincible. Hit close and do the same to the other one. Now to test that your portals are correct click on the joystick so that its not a shady white. When you do that the sheet brushes should not be visible instead you should see right through them and see the boxes with the WarpZoneInfo tags in them. If you do see the boxes you can check that the portals are there by clicking Mode and Zones/Portals, the whole room should be one color except the portals should be different. If this is done correctly you are almost there. Just add lights around the map and then rebuild Geometry, BSP, and Lighting. Play the map and see if it came out right.

Mini-Portal FAQ

I click on the joystick and I see black wholes in the map.

· Rotate the sheets so that the side that’s facing the room is now facing inside the box and vice versa. It could be both sheets or just one of them. Experiment this has happened to me before and I changed the sheets around a bit. After you do rotate it make sure you rebuild the geometry and then see if its still messed.

· Another problem could be that the boxes aren’t the same geometry I have never had this problem but you should make sure they are correct.

· Make sure that the sheets are covering everything on the portal so you can’t see inside. This could be a major problem

· Make sure that the WarpZoneInfo entities are inside the portals boxes.

I play the level and I have portals but they are messed up I see myself but 3 times bigger.

· This also happened to me before, I fixed this by rotating the sheets again.

Basic Trigger Overview

By: Bostich

Dated: 26/5/98

Triggering Movers

I'm only going to cover how to Trigger Movers in this tutorial, otherwise it would go on forever. Okay, I also have no idea how most of the other triggers work. The important class for this tutorial is the Trigger -> Trigger class. As the name suggests, Triggers are used to activate properties of other classes, which means you must remember to edit the properties of both the Trigger and the Target. Triggers need some other object to interact with. 
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Making the Trigger

Let's add a simple Trigger to the room. Go to the Classes menu -> Triggers -> Trigger. Add a Trigger to your room. For the room provided I added the Trigger right in the path between the PlayerStart and the "Door", this way all you have to do is walk forward and you'll see the Trigger in action. There will now be a beautiful little Trigger Icon floating in space. Now go to the Trigger Properties by right clicking on the Trigger Tag (Seen above). Click on Events to reveal Events/Event and Events/Tag. Event is the pointer to the object you wish to act upon and Tag is the name an Event links to. If this is a bit confusing it will be made clear in a second. In the Trigger properties set Events/Event to 'Mover1'. Now go to the Mover Properties by right clicking on your Mover and change the Events/Tag to 'Mover1' if it doesn't already say this. You will now see a red line appear in all views. This red line is the logical link between your two actors.
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Trigger Activation

Your Trigger is now linked to your Mover, but this is not enough. You must properly set the activation types for both the Trigger and the Mover. For this tutorial we want the door to open when the player moves towards it. In the Trigger Properties, look at the Trigger/TriggerType. You will see that it is set to 'PlayerProximity', which is what we want. Click on the right hand column to see what other types of events you can use to activate the Trigger. Now switch back to the Mover Properties and move to Object/InitialState. Click on the right hand column to bring up the states menu. The important states for us are the TriggerX states, which are as follows:

· TriggerPound: Causes the Trigger to rapidly move between states, good for squishy traps. TriggerControl: Causes the mover to change keyframes and remain until the player is no longer within the Trigger.

· TriggerToggle: Toggles the state of the Mover from one keyframe to another, for that open and closed look.

· TriggerOpenTimed: Causes the mover to open for its specified time the close. Time open found in Mover/StayOpenTime.

Set your movers state to TriggerOpenTime. If you compile and run your level you will now have a door which opens whenever your player walks into the Trigger location.

Button Triggers

Not big enough for a tutorial of its own, here's how to make a "button" Trigger. Make another small Mover. Change the Events/Event of your small Mover to the Tag of the "Door" Mover. That's it. Pretty simple, no?

Notes

· Don't forget to add another Trigger on the OTHER side of your door, if you want to get back into the room. The first map I made I forgot this and whoops!

· I suggest placing your Trigger no more than 64 off the floor, unless you want your player to be jumping a lot :)

Triggers

By: Cold Front

Dated: 27/5/98 

While this process is not difficult, it is very complex. It contains many steps that you will have to follow in order to get your triggers working. I suggest that you download the map provided and follow along. If you can not have a browser open while in UnrealEd please print out this document. The first step should be to view the map in Unreal. This will allow you to have a sense of what you will be working with. When you start the map up, walk forward a little bit and you should notice a few things, these being:

· An earthquake

· Explosions

· A Screaming sound, and an earthquake sound

· Music

· On/Off lighting sequences

All of these things were done easily using Triggers.

Behind the Scenes: 

yourself, with my setup as a reference. So before you do anything, CTRL-drag the PlayerStart position (looks like a joystick) over to the empty hallway. The very first thing that you must do is lay down a main Trigger. To do this go to Classes -> Actor -> *Triggers ( If you don't know what I’m talking about, come back to this tutorial when you are more experienced with UnrealED). Expand the *Triggers hierarchy and you should see "*Trigger" (no 's') with a white dash next to it. Click *Trigger once so that it is selected (don't open the hierarchy, do NOT add a ZoneTrigger, just *Trigger). Now, somewhere in the empty hallway Right-Click and choose, 'Add Trigger here' from the pop-up menu. You should see a black box icon. This is your trigger, and is what will set off a sequence of events if the player is within a certain radius of it. With open up your Trigger's properties. Expand the 'Collision' menu. Now notice where it says CollisionHeight and CollisionRadius. These are important factors as they decide how close to your Trigger the player has to get before it is set off. For the sake of this tutorial lets change the CollisionRadius to 240.00 to ensure we set it off in the hallway.

Advanced Users Note: The 'Trigger' menu in properties usually doesn’t need to be touched if you want just your player to set off the trigger, but if you want other items to set it off then change the TriggerType from TT_PlayerProximity to any of the other values such as TT_PawnProximity (Nalis, Skaarjs etc can set it off), or TT_Shoot (bullets, or any other projectiles can set it off) or TT_AnyProximity would allow just about anything to set the trigger off.

Ok, with our CollisionRadius all set. Expand the '+Events' menu in the Properties window. You should see Event and Tag. These are vitally important. I’m not going to give you the whys or whatfors, I’m going to tell you what value you spit in there and let you figure out how the correlate :) Ok for Event: put in 'MyTagName' (sans apostrophes of course). And for Tag: put in 'Trigger' (this value is really insignificant in this tutorial). Ok now, close that Properties window and save.

The next step is to add your first event (the order that you add events really doesn't matter). This being the sounds that will be triggered. Under Classes->*Triggers highlight '*SpecialEvent'. Now add one of these to the hallway. This icon should look like your Trigger icon, but with an exclamation mark on it. Now open up the Properties of your SpecialEvent. Under the Events menu, set Event: to 'None' and Tag: to 'MyTagName'. I said I would go through all this but, basically the Event parameter is what is sent out when the Trigger is activated, and any items like earthquakes, or MusicEvents that have a Tag that is the same as the Event parameter, are activated! So because we are giving this SpecialEvent's Tag the same name as the Triggers event when ever the Trigger is activated it will activate the SpecialEvent. Get it? Didn't think so...

Anyway...as soon as you entered 'MyTagName' as the Tag name you should notice that a red line now connects your Trigger and SpecialEvent. Now, still in the Properties window, under 'Object', change the InitialState parameter to PlaySoundEffect. Then, under SpecialEvent in the Properties window, change bBroadcast and bPlayerViewRot to False if they are not already. Then where it says Sound, choose the sound you want to play when the trigger is activated ( you should know how to do this), and click Use. I choose one of the screams from the Rikers set.

Next, click on the SpecialEvent icon (the one with the exclamation point on it) and duplicate it once (another red line should connect the Trigger and this new duplicate). Keep all of the settings the same, except go back into Properties>SpecialEvent>Sound and choose one of the earthquake sounds from the AmbOutside set.

Save your map.

What you have now will work. As the player gets activates the trigger, you will hear a scream, and an earthquake sound. Lets not play it in unreal just yet, besides its all dark in your hallway right now anyway :) So lets spice things up some more and add Music! Under Classes->Triggers highlight '*MusicEvent', and place this somewhere in the hallway. The icon should look like a serpent's head. Open up the Properties of the MusicEvent, and make the following changes: Under Events, Event should be 'Trigger' and Tag should be 'MyTagName' (are you beginning to see how the whole tag thing works now?). Under MusicEvent, make sure that bAffectAllPlayers is True and that bSilence is False. If you want your song to keep repeating over and over mane bOnceOnly False. Still under MusicEvent, change Transition to MTRAN_Instant. The Transition parameter sets how the music comes in. A setting of Instant will make the music instantly come on, but you could also choose a slow fade or whatever floats your boat. Ok you should notice that another red line is connected from your Trigger to your MusicEvent icon. 

Now lets add an Earthquake! You can find Earthquake under Classes->*Keypoint->*Earthquake. Add one of these to your hallway. The icon should look like a black box with a key on it. Open up the Properties for the earthquake event, and make the following changes: Under Events, Event should be 'None' and Tag should be 'MyTagName'. Notice that I changed from using 'Trigger' as the event to 'None'. This is to show that the Event is not significant in the actions unless you want to have a chain. For instance say you wanted to have the Trigger activate a MusicEvent, and then you wanted the MusicEvent to activate an earthquake, you would just give. Trigger's Tag as IceTea, its Event as 'Coke'. Then the MusicEvent's parameters would be, Tag: 'Coke', Event: 'Pepsi', and the earthquake's settings would be Tag: Pepsi, Event: None. None because its the end of the chain and therefore useless. Not vital if you don't understand this yet. Ok moving on...

Under Earthquake's Properties, expand the Earthquake menu. Let me explain each parameter and you can fill in what you please:

· bThrowPlayer: If this is True then the player will be tossed all around the map during the course of the earthquake. if it is False, then the player's feet will remain planted while the world shakes so just the player's view gets a little shaky. 

· duration: Numerical value in seconds of how long the shaking will last. 

· magnitude: the ferocity of the earthquake, or in layman's terms, "how shaky that bitch will get" anything more than 3500 is pretty ridiculous. 

· radius: not exactly sure but most likely how large of a region around the earthquake event icon is affected. 

For the sake of this tutorial set the values to: True, 3.0, 1500.0, 300.0 respectively. (check the values on my side of the map if you are not sure). There should be another red-line connecting the Earthquake event and the Trigger. 

Now lets add some cool explosions. Under Classes->*Effects you should find '*ExplosionChain*' Place one of these in the hallway, a little farther away from the other events so the player doesn't get blown up :) Change the following in its Properties:

· Events->Event: 'None' Tag: 'MyTagName' 

· Effects->bOnlyTriggerable: True, and None for both sound effects 

· ExplosionChain: Damage 100.0 (this is how much health the player eats when this explosion goes off hear her). Delay time 0.3, Momentum Transfer 100000.0, size 2.0 

Great you should now see a red-line to the Trigger. Now duplicate this ExplosionEvent 2 times. Spread them out a bit like I did. Now we need to make a slight change in each of these 2. Open 1 of the duplicates up and change the ExplosionChain->DelayTime to 0.4 and the size to 1.0. Now open up the other duplicate and change the ExplosionChain->DelayTime to 0.5. 

Now for the tricky part! (heh!) Dispatchers! 

The concept behind a dispatcher is that you can save a lot of red lines on the screen :) I'll tell you what to do and then use what we've done to help me explain what a dispatcher is exactly, but by then it should be obvious. 

Ok, select a Dispatcher from Classes->Triggers->*Dispatcher and place 1 in the hallway. Now under the Dispatcher's Properties set the Events-> Event: to 'MyDispatcher' (again this could be anything), and Tag: to 'MyTagName'. Under Properties->Dispatcher you should see OutDelays, and OutEvents. Click on OutEvents. You have 7 events per dispatcher that you can assign and if you need more just fill one up with 6 events and make the 7th a call to another Dispatcher. Ok from 0 to 7 in OutEvents, fill in the following info: lights1, lights2, lights3, lights4, lights5, onlights1, onlights2, onlights3. Lights1 should be the 0 value and onlights3 should be the 7th. What are all of those values?!? Well, when you light your hallway these will be the Tags for the lights so you can control if the lights are on or off or not! Now, go to OutDelays: and make the values for 0-7 be 1.00. This value is in seconds and represents how long it should pause between executing events. like say I wanted there to be a 4 second pause before it executed lights1 and lights2, I would set OutDelays 0 to 4.00. Get it? Good. By changing all the values to 1.0 you are saying you want a 1 second delay between each of the lights turning on. 

Ok, now we need to place lights in the map. I want you to place them in the same areas I did in my side of the map. BUT WAIT! Do NOT place ordinary lights! You MUST go to Classes->*Light->*TriggerLight (now there are two of these, one with a dash, and one with out, it doesn’t matter which one you choose, but for the sake of continuity, choose the one with the dash next to it). Now place a bunch of these lights in the same places I did. It's best to make one, put it where it should be near a torch, and then duplicate it and place it where it should be on the torch across from it. Before you do any duplicating though, make a master torch to make your duplicates from, and copy the LightColor values I have on my lights and the Lighting values so yours can be that nice fiery orange with a wavy effect. You must set these values for all of the torches (or just that one master torch if you are going to be duplicating it): Under Properties:

· Object->InitialState: 'TriggerTurnsOff' (this setting is saying that we want the light to be on, and then be turned off when we activate the trigger). 

· TriggerLight->bDelayFullOn: True 

· TriggerLight->bInitiallyOn: True (here we are saying we want the light to start off on, this corresponds to the InitialState of the trigger that we set under Object) 

· TriggerLight->ChangeTime: 0.0 

· TriggerLight->RemainOnTime: 0.0 

Then select those two lights and duplicate a few times and place them on the torches. So you should have 10 TriggerLights each in front of a torch (like on my side of the map). Now select all 10 lights and with them all selected, open up the Properties for the lights and under Events, change Event: to 'None' and Tag: to 'lights'. Look at the map and see that the torches are divided up into 5 pairs. Well, each pair will be controlled by one of the 5 values from our Dispatcher! (Confused yet?!). So select the first two torches (and I mean torches facing each other), and under Properties Events: change Tag: from 'lights' to 'lights1'. Then select the next two torches and change their tag from 'lights' to 'lights2' all the way up until you have a pair with 'lights5' as a Tag. 

Almost done... 

Now make a another TriggerLight by duplicating one of the torches...This time in properties change a few values as follows:

· Events->Tag: onlights

· Object->InitialState: 'TriggerTurnsOn'

· TriggerLight->bInitiallyOn: False

Now, in my map, these lights were the red and blue ones that turned on after the map was dark. So duplicate the light you just made 5 more times and place it around the map in the same general area as I placed them on mine (so 3 pairs of lights across from each other). Now like we did before with the torches, we need to set the tags of these 3 pairs to work with the Dispatcher that we setup. So select a pair of the two floor lights you just made and set the tag to 'onlights1' and then with the next pair of floorlights set the tag to 'onlights2', and finally, to the third pair of floor lights set their tag to 'onlights3'. You can now select all 6 of those floor lights and add whatever kind of pulsating effects or colors you want, or you could just copy my settings.

You should be ready to rock! Rebuild the map, and make sure the PlayerStart joystick icon is on your side of the map. Now play that sucker and pray it worked.

Pathnodes Overview

By: Sharky

Dated: 12/8/98 

First off I hope you know how to use the editor and understand the basics of good design and weapon placement. Also you should know how to add actors to your level.

1. First, take a level that is setup the way you want it to look.


2. Make a backup of you level.


3. Then go to classes and under NavigationPoint find PathNode.


4. Start adding path nodes by figuring out the best path through you level. Start placing them far enough apart that they are evenly space but close enough that they are visible from one another. Also try to go past the weapons in your level (when you generate the path it will connect to the weapons). Now that you have all your nodes evenly spaced go into the 3d view and "walk" through your level and make sure they are visible as you go from node to node.


5. If you have any elevators/lifts in your level you must place a lift exit where you want the bot to wait for the lift/elevator and a LiftCenter where the lift is on the ground. Next you assign their lift event to the name of the mover's tag.


6. If you have any Portals in your level you must place a node inside the portal on each side or the bots will not use the portal. I’m not sure about how teleporters work yet but ill add to this once I figure it out.


7. Any doors you have in your level should have path nodes right next to the door if you want the bot to use the door.


8. Also if you have any dead end hallways the bots will probably not go down them unless there is a weapon at the end


9. Now that everything is setup as you want it, hit F8 to bring up rebuild and go to the lighting tab and click on generate path. Rebuild your level and you should be all set to play it with bots.

Pathnoding Unreal Levels for the Unreal Bots

In a very real sense, the Unreal Bots are ONLY as good as the levels designed for them. In other words, for the Bots to play at their optimal best, the Unreal levels must be carefully created for them. While there are many good deathmatch levels out there for human play, there are unfortunately too few that are great for Bot play. (I have seen some levels that can NOT be adequately pathed for the Bots!) This tutorial will attempt to help the level designers design levels that will make the Unreal Bots and the Bot loving community happy.

Where do you begin?

First, design a level with the Bots in mind. This means that you must know the limitations of the Unreal Bots. (Yes, they DO have their limitations!) The Bots do NOT like levels with too much water, lava, slime, or acid in them. Even with good pathing, they either will avoid these areas altogether, or you will always find them jumping in and choking it down. Another little problem with the Bots is they apparently cannot use all of the items (i.e., jump boots, force field, etc.) that the human players might find in their inventory.

All in all, the best levels for the Bots are those that are designed with an elegant simplicity. If a level is too complicated or has a lot of tricks and traps, it will probably present problems for the Bots. Now, while it is tempting to design a killer level with all kinds of bells and whistles, the best levels for deathmatch (whether for humans or for Bots) are those levels that tend to be the simplest in design. Save all of the unique and unusual effects for the single player levels. For the deathmatch levels, the best ones are those that are fast and efficient - given to the one and only goal of "kill or be killed." Of course this does not mean that a good deathmatch level must be boring. Use textures that work well together and support the theme of your creation. But keep the "eye candy" to a minimum. Levels that contain a lot of special effects (i.e., lighting, fog, etc.) will really slow down when a Bot or two are added to them.

Then what?

After a level has been completely designed, pathnode the level for the Unreal Bots. In the "Browse" Menu at the right hand side of the Unreal Editor choose "Classes." Under Actor Classes choose "NavigationPoint." Under NavigationPoint you will be using "PathNode" to path the level for the Bots. And, so the Bots can use the elevators, you will also be using "LiftExit" and "LiftCenter." In one of the Map View screens (Mode: Textures; View: Show Moving Brushes; Actors: Full Actor View) choose the view that allows you the first person perspective so that you can move through the level.

The pathnodes

Under Classes, NavigationPoint, choose and highlight "PathNode." Place the pathnodes in the level by pointing to the location on the floor where you want the node to go, then right click the mouse and choose "Add PathNode Here." The pathnode will appear. (It is a Golden Apple.) Continue pathing the level choosing the best possible route for the Bots. All pathnodes should be placed at key points - next to weapons or items. Each pathnode should be visible to the next pathnode which is in sight of the next node, and so on. (In other words, do not separate the nodes by too great a distance. But, don't place them too close together either.) On stairs, place one pathnode on the floor at the middle of the base of the stairs, and place the next node on the floor at the middle of the top of the stairs. (In other words, you should only have two nodes per flight of stairs: one at the top, and one at the bottom. Try not to put any nodes in the middle of the flight of stairs.) The two nodes should be visible to each other. If there is a landing (that changes the direction of the stairs) place a node on that landing, and, of course, another at the top of the stairs. (Do NOT place a node on every step! Of course spiral staircases present a unique pathing challenge - just do the best you can, with as few pathnodes as possible.) Continue to path the level until you have left a trail of "golden apples" throughout the entire level.

PATHING TIP:
Some areas are very difficult to path because they are too small for the Actor. (You will get a message saying: "Actor does not fit here.") Difficult areas would include ledges that are too narrow, rooms or halls that are too small, etc. One work-around is to place items in these areas, if you know that the player actually can go there. Then place a pathnode as close to this trouble spot as possible. The pathnodes will usually link to the items in and through the problem area when you do a "Path Define." But, the best work-around is this: You can MOVE any pathnode or item to exactly where you want it (moving it in any direction; left, right, front, back, up or down) by selecting it, after you have placed it, and using a combination of the CTRL key and the left or right or left-right mouse buttons, for precise placement. (You can also DUPLICATE an existing pathnode by right-clicking on it and choosing "Duplicate.") This means that you can move a pathnode into an area that gives you an "Actor does not fit here" message. So, you can put pathnodes on narrow ledges, in difficult areas, spiral staircases, etc. You can do the same thing for the elevator nodes as well. One more thing. If you use any portals or teleports in the level, make sure that you place a pathnode just outside the portal, and put a pathnode inside the portal chamber as well. You may have to move the pathnode (as described above) to place it in the best center position.

PATHING TIP:
Every once in a while, you will come across a specific area that almost defies pathing. What do you do? Well, here is a little trick that really works: Use the "LiftExit" and "LiftCenter" nodes! (Just be sure and give both of their LiftTags the same name.) You read that correctly. You can use the elevator nodes to get the Bots to jump or drop to difficult areas that may not easily link when you do a "Path Define." You can even use the elevator nodes to help the Bots get into and out of water more easily. Another interesting use of the liftnodes is in a low gravity room. You can actually get the Bots to jump UP to higher areas to retrieve items. (In normal gravity, they would only jump to the same level or drop down to the next lift node. But, jumping in low gravity gets the Bots to jump higher than they even "expected.") Be creative and find other ways to use these special nodes to move the Bots into and out of unusual areas! One other thing that you can try is to increase the "desirability" of any item that the Bots can get and use. Every item has a "Properties Sheet." In it you will find the "maxdesirability" field. Tweak this number, and the Bots may show a greater interest in the area that is giving you problems.

PATHING TIP:
Then there is the dreaded "camping" problem that sometimes happens even when a level seems to be pathed correctly. I have found that the only thing that usually works is to (sometimes drastically) change the weapons and items placement, not just the pathnode placement. Even then, be aware that the problem may not entirely go away. A different kind of problem is seen when dealing with an area that the Bots just won't frequent. (This often happens with "dead-end" rooms and areas. Remember it is best to design your levels where there are NO "dead-end" areas. Make sure that every area has an entrance and an exit for better game flow and for better routing. If you simply must have a "dead-end" area, make sure that you have something really significant in that room that will give the Bots a reason for going there.) If you follow the Bot around in Spectator Mode, you will realize that in almost any level the Bots tend to follow a predictable path. This path may leave certain areas out of the Bots territory. This problem too, demands a sometimes radical solution: Change the weapons and items placement. This is a frustrating solution to an aggravating problem, but it usually does work. Don't give up! Keep at it until the level flows smoothly and works well in Bot play. If one pathing or weapons and items placement does not work, try another.

PATHING TIP:
To get the Bots to "use" a button or switch, you must place a Trigger in front of the button. The Trigger must be set so that it will "push" the button AND also activate the object you want the button to open. This is rather complicated, so for purposes of illustration, let's assume you want a button or switch to open a door. FIRST, put a Trigger in front of the button and open its Properties Sheet. Under Events, you see a field for Event and Tag. In the Event field put "Door" and in the Tag field put "DoorTrigger." Under Object of the Properties Sheet for the button the Initial State should be "NormalTrigger." Under Trigger of the Same Properties Sheet, put "True" for InitiallyActive and "False for TriggeronlyOnce. For TriggerType put "TT_PlayerProximity." SECOND, go to the Properties Sheet for the button or switch (the button or switch is actually a "Mover") and under Events, in the field for Event put "None" and in the field for Tag put "Door." Under the Properties Sheet, Mover, for the BumpType put "BT_PlayerBump." And Under the Properties Sheet, Object, for the InitialState put "TriggerOpenTimed." THIRD, go to the Properties Sheet for the door (this is also a "Mover") and go to Events. Under Event put None and under Tag put "Door." Under the Properties Sheet, Mover, for the BumpType put "BT_PlayerBump." And Under the Properties Sheet, Object, for the InitialState put "TriggerOpenTimed." (NOTE: There are quite a few other fields that you can choose to effect various aspects of the button and the door, but the above fields in the Properties Sheet tie the trigger in with both the button and the door. What you have basically done is make the trigger activate the "Door" - the name of the Events Tag for BOTH the button mover and the door mover. By the way, you should realize that you must set the time delay for the door so that it will stay open long enough for the Bots to actually go through that door. What is more, there must be something behind that door that is worth getting, like a SuperHealth or a weapons cache. Then that door must stay open long enough for them to get out of that room.)

PATHING TIP:
One of the hardest things for the Bots to do is navigate through water. (Perhaps the best advice is this: Do NOT put any pathnodes in the water unless you have to!) If you must have them "take the plunge" make sure that there is a very good reason for them to get all wet. Some good reasons would include items and weapons in the water (If you place items in the water, you should raise them off the ground about a foot or so. Otherwise, the Bots will get hung up trying to get the item while in swimming mode.), or the need to move into another area of the level. Do NOT make the Bots wander through underwater labyrinths just for "fun." (The Bots have a nasty habit of drowning, especially in deep water. In fact, it looks like the Bot's AI does not always tell them to go UP for air! Another little problem the Bots appear to have is that sometimes they stop swimming and go into a walking or running mode underwater. This almost always means a sure death, unless their swimming AI kicks back in.) Place the pathnodes in the water like you do on land. However, if the water is deep, you may have to move the pathnodes (up or down) into the most efficient path possible. (Sometimes, for some unexplained reason, the pathnodes under water do not always connect properly, especially if the water is deep. Make sure that you go back into the water after a Path Define to check that all the water nodes are linked properly.) Always put pathnodes at the water's edge, and put several of them at various points along the water's edge so the Bots can easily jump out of the water. One or two more things, do NOT place any pathnodes above the water. And, remember, you can use the liftexit and liftcenter nodes in and around water. But, use them only to get the Bots in and out of water areas. Do NOT use these lift nodes to try and get the Bots to move through vast underwater areas. These elevator nodes will cause the Bots to pause at the various points (or sometimes change direction) and then all they will do is choke it all down. (And, don't even think about trying to path the Bots through acid, slime or lava.)

The elevators

Do NOT use "PathNodes" (Golden Apples) for the Elevators! They do not work! Instead use the "LiftExit" and "LiftCenter" nodes. (These nodes look like a Griffin's head.) Place the LiftExit node where you want the Bot to WAIT for (or get off) the elevator. But, do NOT place the LiftExit too close to the actual elevator brush itself. If you do, and the Bots get too close to the elevator, they will active the lift too soon. (Use the same procedure as you would a regular pathnode. Point at a spot on the floor just outside the elevator platform brush and right click to place the LiftExit.) You must have at least TWO LiftExit nodes. One for the bottom of the elevator and one for the top. (You can have more than one entry or exit nodes, but it is best to only have one for each floor.) Place the LiftCenter node in the center of the elevator area, on the floor where the elevator brush is. This is where the Bot will stand and wait until the elevator reaches the top - if you do everything else correctly. (NOTE: Do not place any nodes, of any kind, in "mid-air", floating far above the ground. They must be placed at approximately "waist-high" level above the ground.)

This next step is CRITICAL to getting the Bots to use the elevators properly. (In other words, to keep them from jumping off the elevator too early, or to keep them from standing under the elevator, etc. EACH ELEVATOR MUST BE GIVEN A UNIQUE NAME, AND EVERY "TAG" ("LIFTTAG") MUST BE SET ACCORDINGLY, AND THE ELEVATOR'S MOVER PROPERTIES MUST ALSO BE SET PROPERLY! Each elevator node (LiftExit and LiftCenter) has its own properties sheet. Right click on them and you will find their properties. When you are in the LiftExit Properties choose "LiftExit" and then "LiftTag". Give a name to that tag that will be used for that elevator and all its tags. (Each elevator MUST have a different name.) Do the same with the LiftCenter LiftTag. Give it the same name that you gave to the LiftExit for that elevator. NOW, and this is absolutely essential if the Bots are to behave themselves on the elevator, you MUST select the elevator brush, then right click that highlighted (pink) brush and choose "Mover Properties." This will give you the Properties Sheet for the selected elevator. On this Properties Sheet choose "Event" and then "Tag." Give the elevator the same name as its LiftExits and LiftCenters. This will "link" the elevator with the LiftExits and the LiftCenter nodes.

Bot Trivia: Did you know that the Bots can "call" elevators, but you can't? It looks like the Unreal Bots know how to "push all of the elevator's buttons" to use the elevators to their own advantage. If the Bot is at the top of an elevator shaft and the elevator is on the ground level, the Bot can actually summon the elevator. Hey, we can't do that!

The path define

If you have completely pathed the level and properly pathed the elevators as well, the next step is to go to "Options" and choose "Rebuild." Under Rebuild, choose the "Lighting" tab and then you will find the "Paths Define" button. Press this and the level will be processed and pathed. (This can take several minutes!) After the level is pathed, choose "Close." Then go to "File" and SAVE THE LEVEL. (Of course, you should be saving the level all along at various stages of development.)

Auto bot tip

You can make your level automatically add Bots by going to Options, Level Properties, Level Info, and under Default Game Type put: Class'Unreall.DeathMatchGame' (The way you place this in the field is to, under Browse Classes, choose: Actor, Info, Game Info, Unreal Game Info, and then highlight "DeathMatchGame." Then in the Level Properties field for "Default Game Type", which probably says "None", click on the field and then select "Use." Because you have highlighted "DeathMatchGame," this will be placed in that field. Be sure and save the level now.) This will automatically bring Bots into the game when you start the level. So, you can just double click on the name of the level in Windows Explorer to fire up a game (and then close Explorer when the Unreal Log starts) and you don't even have to fool with the BotMatch Menu! (This option reads your Bot Configuration file in the unreal.ini, so make sure that you have at least one Bot selected for BotMatch.) If you want to bring in other Bots, just go to the console and type in: addbots x (where "x" is the number of Bots you want).

The final steps

Unfortunately your mission to create a killer Bot level is not done. There are a few more steps that you really must take, if you want your level to be a top Bot level. First, go back into UnrealEd and load the map. Go through the level in the 3D view and look at ALL the pathnodes. Are the pathnodes and their links neat or sloppy? (It does usually make a difference! Remember, you are actually laying out the exact route that the Bots will take through the level.) Especially pay attention to trouble areas like stairs or areas around lava or portals! Look for any pathnodes that are too far off the ground. Also, while in UnrealEd look at each elevator and their special pathnodes (LiftExit and LiftCenter) to see if they are placed and linked properly. And, if you are really brave, turn the "View Paths" option on and follow the pathnodes, looking for any broken (i.e., unconnected) links. All of the paths will appear as blue and red lines that connect all of the nodes and items. Fix any problems and then do another "Path Define" and save the level.

Secondly, whether the level was tweaked or not, go into Botmatch with ONE Bot and use "Spectator Mode" to follow the Bot through the level. Look for problems: areas where the Bot gets stuck and run in place; areas where the Bot does not go; excessive camping; etc. Then add one more Bot and watch them interact for a while. Next add several more Bots into the level and go spend time in each room/area looking for any problems. This second step will catch things you can't see in UnrealEd. If Bots don't move through a level, even if the pathnodes are great, you may have to change weapons/items placement. Sometimes Bots will just get stuck on several items if they are placed all in a row. To fix this, you have to break up the items placement. Avoid straight line series placement of ammo and health. Sometimes you just have to delete and then re-place the item that gives the Bot a problem. You should realize that some Bot problems will be solved by just having another entity (Bot or human) to interact with, but observing a single Bot in the level while you are in Spectator Mode is very revealing. Watching the Bots, you really begin to notice all kinds of things that will teach you the ways of the Bots.

For a variation of the "Spectator Mode" you can also go to the console while the Bots are in play and type in "viewclass femaleonebot" (or femaletwobot, maleonebot, maletwobot, malethreebot, etc. depending on which Bot you have in the game).

Finally, go into Botmatch and go one-on-one against the Bot on your level. Then bring in a few more Bots for a good old fashioned free-for-all. The better you have pathed and optimized the level for the Bots, the better they will play . . . and the more you will die!

Yes, this is a lot of trouble! But it is an essential part of quality level design. Remember, our ultimate goal is not to just build a good level for human deathmatch play, but also to build a better level for the Bots.

Closing hint

If you run across a level that someone else made and the Bots don't play it well, you can always fire up UnrealEd and follow all the steps in this tutorial to make your own Bot improvements. (But, if you want to re-release the Bot improved level, please be sure and get the permission of the level designer first.)

Please let me know if there are any corrections or additions that need to be made to this tutorial. Thanks!

 For other Unreal tutorials and information on related subjects be sure and see UNREALED.NET.

A very special thanks to Robert Field, of Frog Bot fame. Without his patient help, I would have never figured out many of the problems we have encountered with the Unreal Bots. And a special thanks to Erik and his unique pathing tips on the special use of elevator nodes. And a special thanks to Donzella for his additional tip on using the elevator nodes in water. And a special thanks to Ewan for his "viewclass" tip.

Randar

This document was collected and edited by Fleshdance.

Authors:
Millenium
Isolation
Randar
Cold Front
BEG
Mark Poesch
Knives
KarB

Source:
http://www.unrealed.net/
� EMBED Word.Picture.8  ���








[image: image94.jpg]WaterPaint

BumpMaphngle 170
Bumphapliht 50

DiopType: DROP._PhaseSpat
FX_Ampitude. 25

FX_Depth 25
FX_Frequency 8

FX_Phase 8

FX_Radus 128

FX_Size 1l

FX_Spesd 25

F<_Time. 1l

FhongRange 180

PhongSize 2

Wavehmp 128



[image: image95.jpg]


_974841411.doc
[image: image1.png]The "mover" itself. Itis currently
selected, so it s bright purple.

The doorway we cut out.

The hole for the door. ’








